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Chapter 1
INTRODUCTION

SignalTrack is used with Doppler Systems Direction Finders to provide the user a way to

Monitor and control the direction finder
Network fixed site and mobile direction finders
Display bearing data from a network of fixed site direction finders

Control the frequency of each receiver on the network

v v Vv v WV

Display fixed and mobile site position and lines of bearing

IN THIS CHAPTER

Typographical CONVENLIONS.......ccveureureuecercereenerrennesseeeeeeaseesessessesseasesssessessenne 2
USINg This Manual.........cceceueererieieicieisesesieeeiseisessessessts e ssessessessessesessessesens 2
Overview of the Programs..........ccensencencenesneuseseseseseesessessessessessessesenne 2
Computer REQUIFEMENTS .......cc.vcueeeureenceeeceeenessesneaseseseesessessessesseasessesessesesens 4
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TYPOGRAPHICAL CONVENTIONS

Before you start using this guide, it is important to understand the terms and typographical
conventions used in the documentation.

For more information on specialized terms used in the documentation, see the Glossary at the end
of this document.

The following kinds of formatting in the text identify special information.

FORMATTING CONVENTION TYPE OF INFORMATION

Triangular Bullet(>>) Step-by-step procedures. You can follow
these instructions to complete a specific
task.

Special Bold Items you must select, such as menu
options, command buttons, or items in a
list.

Emphasis Use to emphasize the importance of a point
or for variable expressions such as
parameters.

CAPITALS Names of keys on the keyboard. for

example, SHIFT, CTRL, or ALT.

KEY+KEY Key combinations for which the user must
press and hold down one key and then

press another, for example, CTRL+P, or
ALT+F4.

USING THIS MANUAL

This manual is organized to get you up and running as quickly as possible. Following the introduction,
chapter 2 will lead you through the installation process and guide you in configuring the programs.
Chapter 3 describes the creation of maps for SignalTrack using the MapFix utility program. Chapter 4
instructs you on using SignalTrack. Chapter 5 briefly describes the networking of direction finders
for SignalTrack. Chapter 6 defines error messages and their potential source.

OVERVIEW OF THE PROGRAMS

The SignalTrack installation CD installs the SignalTrack application and a number of utility
applications that are used in conjunction with it.



Introduction

SIGNALTRACK

SignalTrack is used get data from a direction finder and to network fixed and mobile direction finders
and display their bearing data on a map. It uses the bearing data obtained from the direction finders
to estimate the location of the radio frequency emitter. It controls the receiver frequency on the
entire network and is able to adjust the direction finder settings of the direction finders at the fixed
sites. It also logs data from each site and keeps a playback file allowing the user to playback recorded
while the system is direction finding on a source.

MAPFIX

MapFix is a utility program used to make SignalTrack usable maps from graphics files. Any graphic can
be used as a map allowing maps to be hand drawn, scanned in, or captured from one of several
commercially available map programs.

LOGVIEWER

LogViewer is a utility application used to view the log files created by SignalTrack. The log files are
saved as tab delimited text files and can be opened by most spreadsheet programs such as Microsoft
Excel. LogViewer can be launched directly from the SignalTrack File menu and lists the file from
newest data to oldest data.

WINRDFCOMMAND

WinRDFCommand is a utility program that can be used to change the direction finder settings. The
full array of settings and the explanation of what they mean can be found in the DDF6001 Hardware
manual. Typically the user will use WinRDFCommand to change the CIV address of the direction
finder for use in a network.

AUTODFTEST

AutoDFTest can be used with a DDF6002 to adjust its parameters. Generally it is not necessary to
make any adjustments; however, in some instances you may want to. An explanation of the
commands is given in the DDF6002 manual.

ESRI ARCGIS MAPPING ENGINE

The ESRI ArcGIS Mapping Engine is installed using the Doppler install program located on the CD.
SignalTrack is designed to use ESRI compatible maps similar to ArcMap (see www.esri.com
http:/lwww.esri.com). Use of the ArcGIS Engine requires a separate license file that is available for
purchase from Doppler Systems or can be purchased directly from ESRI.
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COMPUTER REQUIREMENTS

» Pentium class computer running Windows 2000 or Windows XP
» | GHz clock rate (Dual core processor suggested if using ESRI mapping option)

» 256 MByte RAM (512 MByte recommended if running Windows XP) (2000 MB if using the ESRI
mapping option)
» CD ROM drive

» Serial port or USB-to-serial convertor (| additional serial port is required if networking using a
radio modem)

» Ethernet connection (if networking via Ethernet)



Chapter 2
INSTALLING SIGNALTRACK

To install the SignalTrack Software place the furnished CD in your computer's CD drive. The
Doppler Software installer application will launch. Press Install SignalTrack (DDF6001) and follow
the on screen instructions.






Chapter 3
MAPS

SignalTrack is capable of using two types of maps:

» Maps made from bitmap files

» ESRI maps and map data

A utility program, MapFix, is provided to allow you to convert bitmap files into SignalTrack usable
maps. This chapter contains a description of MapFix and instructions on how to convert bitmap type
maps into SignalTrack maps. Also provided are instructions on making bitmap files from Google
Earth and Microsoft MapPoint.

The ESRI ArcGIS Mapping Engine is provided on the installation CD. The user is required to obtain a
license to use this engine. When installed and licensed the ArcGIS engine provides a high level
mapping capability using user supplied data (see www.esri.com http:/lwww.esri.com). This chapter
provides instructions on how to use ESRI maps and ESRI compatible mapping data.

IN THIS CHAPTER

Creating Maps UsiNg MapFiX........ccccocveureremnerenensenseneenernenenesessesessesessessesscssens 9
Using the ESRI ArcGIS Mapping ENgine ......ccccveveurerenenreneenerneneseseseeeeene 15
GOO0GIE EArth ...ttt e sseaens 27






CREATING MAPS USING MAPFIX

Maps are required to display the bearing data and the estimated location of the radio frequency
emitter. To create a SignalTrack bitmap based map use the MapFix program, which is installed on
your hard disk in the same directory as SignalTrack. An icon for MapFix is placed in your Doppler
program group. With MapFix you can import an image and assign latitude and longitude coordinates
to it. Then save the file and you are ready to use the map in SignalTrack.

Technically, a SignalTrack map is a pixel-based image (a bitmap) that is stored in a file together with
coordinate information. To make a map, you must first create a map image and store it in a graphics
file. You can create a map image by using a commercially available map program or by using a
scanner. When you have such a file, you import it to Map Fix. The next step is to assign coordinates
to the image. When you have assigned coordinates, you can check the coordinates of any location by
moving the mouse. The latitude and longitude of the cursor location are displayed at the top of the
screen. Finally, you save the image with coordinates as a map file.

There are some things you should consider when making a SignalTrack map. If the map has many
details and/or is very dark, you might find it hard to see bearings on the screen. It is advisable to use
a map with fairly pale colors or with limited detail.
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CREATING A MAP IMAGE

To make a map you first need a graphics file containing a map image. You cannot use MapFix to
create this file. A convenient way of making a graphics file is to use a map program (see "Using
Microsoft MapPoint" on page |12). Alternatively, you could scan in an image from a hard copy map
or obtain one from a web site such as Google Earth or Google Map. You can even use a photograph
of a map if you would like. Since graphics files consume space on your hard disk, you might want to
delete them after you have used them to make SignalTrack maps.

GRAPHICS FILE FORMATS

There are a great number of file formats for storing images. Almost all of these are pixel based. A
given format can usually store several kinds of images (different numbers of colors per pixel and
different compression schemes). It is also possible to store an image as graphics drawing commands
(the Windows Metafile Format is of this type). Map Fix only handles can open JPEG (.jpg), bit map
(.bmp). or GIF (.gif) files. Common programs such as Microsoft Paint or Microsoft Imager can easily
convert any standard graphics file into a suitable image.

SCANNING IN AN IMAGE

If you create a map image by scanning it in from an image on paper, make sure that you orient the
paper image with north in the upward direction, so that latitudes become horizontal and longitudes
vertical. If the latitude and longitude lines on your map are not clearly visible make sure to mark the
latitude and longitude of two points on your map (preferably near diagonal corners). You then use
your scanning software to save the image as a graphics file.

11
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USING GOOGLE EARTH

Google Earth provides an excellent interface for making map images for SignalTrack. Use the
following guidelines to create a map. See the Google Earth help file for more information on using
Google Earth.

»

Install Google Earth per instructions found at www.earth.google.com (see Google Earth -
http://www.earth.google.com)

Run Google Earth and use the controls to select the area of interest
Make sure the Sidebar is showing. If it is not showing then select it in the View menu

In the Sidebar click on the features you want to show on your map. Typically you would select
roads as a minimum

In the View menu uncheck all items except Status Bar
Press the F11 key to expand the view to full screen

Use the Placemark selection in the Tools menu to add two placemarks to the map. Note the
longitude and latitude of each placemark. It is best to select placemarks near diagonally
opposite corners of the map

Press Ctri+Alt+C to copy the map image to the clipboard

Launch a graphics program such as Microsoft Paint and paste the image on the clipboard
into the program.

Save the image as a bitmap

USING MICROSOFT MAPPOINT

Microsoft MapPoint or other similar mapping software applications can also be used to create maps.
To use Microsoft MapPoint follow the instructions below.

4
4
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Launch Microsoft MapPoint and select the area of interest

Use the Options menu (MapPoint 2006 or later) to display the longitude and latitude in
degrees minutes seconds

Select Location Sensor from the Tools menu

Use pushpins from the toolbar at the bottom of the display to mark two locations on the map.
Note the longitude and latitude of each location. It is best to select locations near diagonally
opposite corners of the map.

Press Ctri+Shift+C to copy the map onto the clipboard
Open a graphics program such as Microsoft Paint and paste the map image into the program.

Save the image as a bitmap
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USING MAPFIX

MapFix is a utility program supplied with SignalTrack used to convert the bitmap files of the maps
you've saved into map files that can be used with SignalTrack.

IMPORTING THE IMAGE

To import a graphics file containing a map image to Map Fix, select the Import option from the File
menu or click the Import button on the tool bar. A file open dialog appears. Then go to the
directory where the graphics file is located, select the file and click OK. The map image then appears
on the screen

ENTER CALIBRATION POINTS

Using commands in the Enter Points menu or on the tool bar, you assign coordinates to your pixel
image by specifying the latitude and longitude or MGRS coordinates of two locations on the image.
Thus, you need to know the location of two points that you can identify and select with the mouse.
You are free to choose any two points, except that they must define a rectangle (they cannot line
up). To achieve maximum precision, you should see to it that the two points are fairly far apart,
preferably along a diagonal of the image. The following commands appear in the Enter Points menu:

Fix Point |: Determine the location and coordinates of the first point. When you select this option,
the cursor changes to a cross. Move the cross to the first location and click the mouse. Enter the
latitude and longitude or MGRS coordinates of the location in the dialog box that pops up. The
location you have chosen is marked in red on the screen. If you are not satisfied, select Clear
Point | from the Enter Points menu and repeat the process.

Fix Point 2: Determine the location and coordinates of the second point. When you select this
option, the cursor changes to a cross. Move the cross to the second location and click the
mouse. Enter the latitude and longitude or MGRS coordinates of the location in the dialog box
that pops up. The location you have chosen is marked in blue on the screen. If you are not
satisfied, select Clear Point 2 from the Enter Points menu and repeat the process.

Clear point | and Clear point 2: Use these options if you want to start over fixing points.

Pozitian
Latitude IN j I 23 I 50 I 57.84 & DegMin Sec
Longiude [w =] [111 [ 58] 667 | & Deahdin

MGRS I 125%C 10572 45873 I MGRS

Fix Cancel

Figure I: Enter Position of the Point Where You Clicked

13
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After you have entered both points the map is now calibrated. As a test of the calibration you may
move the mouse to other known locations and read the position from the tool bar. If there is a
discrepancy then you may have made a coordinate entry mistake. To correct the mistake simple
clear the fixed points and start over.

SAVING THE MAP FILE

Use the Save Map As option in the File menu to open a dialog where you can save the map image
with coordinates to file. The file name extension for a SignalTrack map file is .MAP. Type in the map
name you wish to use in SignalTrack. If you save the map to the Map subdirectory, SignalTrack will
automatically load these maps when the program is first started. However, you may save the maps
anywhere on your hard disk. Saving a map is available only after you have imported a graphics file
and fixed the coordinates of two points on the map

14



USING THE ESRI ARCGIS MAPPING ENGINE

This section provides instruction on how to use ESRI maps in SignalTrack.

15
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INSTALLING AND LICENSING THE ESRI ARCGIS MAPPING ENGINE

Prior to using the ArcGIS Mapping Engine, you must obtain a license to use the engine on your
computer. This license may be obtained from Doppler Systems LLC (www.dopsys.com
(http:/lwww.dopsys.com)) or it can be obtained directly from ESRI (www.esri.com
http:/lwww.esri.com). We do not recommend installing the Mapping Engine until you acquire the
license.

» Installing the mapping engine

To install the ArcGIS Mapping Engine, insert the installer CD and wait for the Doppler installer
program to launch. If it does not launch, use Windows Explorer to navigate to the CD and double
click on Doppler.exe. Push the Install ESRI ArcGIS Mapping Engine button and follow the
instructions on the screen.

» Obtaining the License File

To install the license you must use the license number you were provided to get a license file from
ESRI. Go to the Start menu and select ArcGIS->Software Authorization to display the
following dialog:

17
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Software Authonization Wizard

Registration Options
You must reqister the software prior to uze. Select fram the options below.

Figure 2: Dialog Used to Register Your ArcGIS Engine License and Obtain a License File

Select the first option and the following screen will be displayed

18
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Software Authonization Wizard

Reqgistration Method
Select the method you want to use to register the zoftware.,

19
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Select the option you would like to use and then press the Next button. After pressing the Next
button follow the instructions for the option you've selected.

» Installing the License File

After obtaining the license file you must then install it into the ArcGIS mapping software. To install it
go to the Start menu and select ArcGIS->Software Authorization to display the following
dialog:

Software Authorization Yizard E

Registration Options
ou must register the software prior to uge. Select from the options below.

F

— Reaistration Optionz
™ | have installed my software and need to register it

™ | have already regiztered the software and need to register additional options or
extenzions.

% | have received an autharization file from ESRI and am now ready ta finizh the
reqistration process.

¢ Back I Mext > I Cancel

Select the third option and press Next.

20
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Software Authorization Wizard Ed

Software Authonization
Select from the fallowing options.

| received the autharization file by email and have saved it to disk.

|| Browze... |

™ | received the autharization file by fax, phore or mail and need to marnually
enter rmy authorization information.

¢ Back I Mext » I Cancel

Press Browse and navigate to the license file and press
Figure 3: Authorizing a File Obtained by e-mail Next.

21
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Software Authorization Wizard Ed

Authonzation Complete

AR

Y'ou have authaorized the following features:

standardengine -
Adengine

interopengine

gdbedit

maplexengine

networkengine j

If you want to enter authorization information for any additional features, Click Back.

Congratulations, your software haz been authorized and is now ready for uze.

¢ Back I Finizh I Cancel

Figure 4: Authorization Complete Will Display Dialog Above

The Authorization Complete dialog signifies the license was properly installed and now the ArcGIS
Mapping Engine can be used in SignalTrack.

22
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ESRI ARCGIS MAPPING DISPLAY

The figure below shows the ESRI mapping tool installed in SignalTrack. The tool consists of a display
pane and a tool bar containing a number of tools that can be used to open, save, build, and
manipulate the maps.

ﬁ PhoenixMizzsion Phoenix Area

File  “iew Maps Channel:  Setup  Help

i (-l iezss0000 - @ | N9 40 48907 w79 3318890 | 10/8/2008 32853 PM
B Lyers - B [@Q M RIS € 2 2

Figure 5: ESRI Mapping Tool Installed in SignalTrack

23
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MAPPING TOOL BAR

The graphic below illustrates the mapping tool bar.

Open

AN

Fixed
Zoom Fan Zoom
Save  Layers In Zoom In Fixed  poveto

Iiap fienu Foom Location

Ot

[/ /

e B [RQ M @I € 2
|3_Imageny_Prime_wiold_20 \

Add Data...

Select ot l FoomPan

Presious plast
Extent Extert

Remove Layer... Full
Extent

» The Open Map tool displays a standard open file dialog that displays

Figure 6: Mapping Tool Bar ESRI mapping files that can be opened into the display.

v v Vv v Vv
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The Save Map tool allows the user to save any changes that have been made to the map

The Layers drop down menu allows a user to enable and disable layers, add data (layers), and
remove layers

The Select tool allows the user to manipulate standard elements such as sites.

The Zoom In tool allows the user to select a rectangle on the screen and the map will be
zoomed to fit into the rectangle

The Zoom Out tool allows the user to zoom the map to a greater extent depending on the size
of the rectangle selected

The Pan tool allows the user to pan the map display

The Zoom/Pan tool allows the user to zoom while panning (you have to try it to see how it
works)

The Fixed Zoom In tool zooms the map a fixed amount

The Fixed Zoom Out tool zooms the map out a fixed amount

The Previous Extent tool allows the user to undo a map manipulation (e.g. zoom)
The Next Extent tool allows the user to redo a map manipulation (e.g. zoom)

Move to Location allows the user to input coordinates and the map will then automatically pan
to these coordinates. The coordinates can be entered in a number of formats including degrees-
minutes-seconds, decimal degrees, and MGRS
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BUILDING MAP FILES

SignalTrack uses ESRI map files (*.mxd) as the base map. Data to make the map files is available from
a variety of sources and SignalTrack can use this data to build ESRI map files.

ESRI maps are built in layers. Each layer of the map is built from standard map data files that use one
of the following formats:

4
4
4

4
»

Shapefile data (*.shp)
Geodatabase data (feature classes, geometric networks, topologies, network datasets).

Raster data (Imagine Image (.img), Bitmap (.bmp), JPEG (.jpg, .jpeg), Portable Network Graphics
(.png), Graphics Interchange Format(.gif), Tagged Image File Format (.tif, .tiff), Arc/Info & Space
Imaging BIL (.bil), Arc/Info & Space Imaging BIP (.bip), Arc/Info & Space Imaging BSQ (.bsq),

DTED Level 0-2 (.dted), ERDAS 7.5 LAN (.lan), ERDAS 7.5 GIS (.gis), JP2 (.jp2), MrSID (.sid),
RAW (.raw), NTIF (.ntf), USGS Ascii DEM (.dem), XI| Pixmap (.xpm), PC Raster (.map), PCI
Geomatics Database File (.pix), JPC (.jpc), J2C (j2¢c), J2K (.j2k), HDF (.hdf), BSB (.kap), ER Mapper
ECW (.ecw)).

Server data (ArcGlIS Server, ArcIMS, WMS (Web Mapping Service) services)
Layer files (*.lyr)

After the map layers are added SignalTrack can save the map as an ESRI map file (*.mxd). SignalTrack
can then be used to open and manipulate (zoom, pan, etc) the map files.

To build map files from data, select Open Map from the SignalTrack File menu and navigate to the
file Blank.mxd. Next select Add Layers from the Layers menu. The following dialog will be
displayed.
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Add Data |
Create Mew Connection: 231 ArcGIS Server 25 ArclMS 2 WwMS
(=] services, arcgisonline, com
|"r|-‘l 2
Shapefiles

=k

Geodatabases

-
-1
I

=

LLLL

Rasters

©

Servers

>> Dataset: I Cpen

Layers

Showe of bype; IMap Services j Zancel

] Use this dialog to select the data you want to use to build the
Figure 7: Select the type of Data to Add  |3yers of your map. Select the type of data you wish to add from
the left window and then select the data in the main window.

After you have built up the layers press the Save Map button on the mapping tool bar.

MANIPULATING LAYERS

Once you've loaded a map, individual layers can be disabled and enabled. The Layers drop down
menu lists all the layers in the order in which they are displayed. The topmost layer is the first layer
in the list; the next layer is listed second, etc. A check box next to the layer name indicates that the
layer is enabled and being displayed. Many times layers above other layers obscure layers below
them. So, to see the lower layers you must disable the layers above the lower layers. Merely
enabling (checking) a layer may not display that layer if the layer above it obscures it.

Layer can be removed by selecting the Remove Layer menu item from the Layers drop down
menu. When the dialog is displayed, check the layers you wish to remove and press OK.
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GOOGLE EARTH

SignalTrack can use Google Earth directly as a mapping display. To use Google Earth it is necessary
to first make a bitmap based map using MapFix (see "Creating Maps Using MapFix" on page 9) as
described previously or to use an ESRI map file. Note if you use an ESRI map file your computer will
require 4 gigabytes of RAM or you may try setting the RAM cache for Google Earth to a smaller
number. In general we do not recommend using ESRI maps when using Google Earth. Next you
must install Google Earth from the Google Earth http:/learth.google.com/ website. SignalTrack
requires Google Earth 4.3 or later.

CONFIGURING SIGNALTRACK TO USE GOOGLE EARTH

To use Google Earth as a mapping display first open a map made with MapFix or an ESRI map.

Note if you intend to use an ESRI map it is required that you have at least 2 gigabytes of RAM and 4
gigabytes is recommended.

Next go to the Setup->Options menu and click on the Display tab to show the following dialog.

Scan | Alert Suundsl Adminislraturl
Times Display | Radio Modeml Hemotesl Slave | Loggingl Plavback | Encryption

Latitude/Longitude Display ™ Show MGRS
’7(: v wt O w I~ Enable Google Eatth

Puasition Estimates

Mumber of Bearings ta Display 1
Estimate Color
Mumber of Estimated Positions To Dizplay I 10

Update Color |
Bleed In Time [ms] 400

Average Color
¥ Held Last Measured Bearings far I 30 s ;I

V' Hold Average Position Estimate for 30 s Wirtual Site Colar |

Check the Enable Google Earth checkbox and press Apply or OK.
Figure 8: Display Options Dialog

If Google Earth is installed on the machine in the default location it will immediately start up.
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MANIPULATING THE GOOGLE EARTH DISPLAY

When using Google Earth as a display, none of the functions that require mouse clicks or keyboard
entry are enabled on the display. To perform functions such as adding or moving sites, enabling or
disabling sites, etc you must go back to a bit map based map or an ESRI based map.

When Google Earth is first launched the display will appear as shown below

File Edit View Tools Add Help
¥ Search I [ﬁ %Jf 0+°?3>+ @+

Fly Tor | Find Businesses I Direc‘tionsl

= Google Earth !Elm |

Fly to e.q1., Hotels near JFK

| =

2)m)x)
¥ Places Add Contert

= CIas mty Places
& Sightsesing
Select this folder and click on

i the 'Play' button below to start
= V19 Temporary Places
@ SignalTrack

— | el
¥ Layers

= @ Pritmary Database -
M ceographic wisk

- == Rosds

B Oy 20 Buildings

-0 Street Wiew

2] 'll‘:' Borders and Labels

- E Traffic Image NASA

£ L% weather . ) ® 2008 DMapas

5 Ol callery © 2008 Europa Technologies

# @ clobal o . © 2008 Tele Atlas N
- hdfl se°57'33.80°N 9501555, 74" W Eyeatt €835.70m O

W B e B

Figure 9: View of Google Earth When it First Starts Up

To view the sites that are currently shown on the base map simply double click on the Folder
marked SignalTrack in the Temporary places folder. Google Earth will then automatically zoom to
display the sites shown on the base map similar to what is shown below.
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File Edit Wiew Toolz Add Help

Fly To | Find Businesses I Direc‘tionsl ! y Doppler

Fly to e.q1., Hotels near JFK

| =8l

=t LIS bty Places
H & Sightsesing
Select this folder and click on
the 'Play' button below to start
= 143 Temporary Places
E SignalTrack

[+ \a" Geographic Wek

- == Rosds

= O 30 Buidings

- O ﬁoﬁ Street Wiswr

2] P Borders and Labels

- OB wafic

s [ ’ﬂ’ Weather

H e Gallery

3] D@ Global Svareness LI

I Fi

W B e B

Eye alt

. ) . ) ~ Once the Google Earth display is shown all the normal
Figure 10: Display When SignalTrack is Running - gisplay manipulation that is possible with Google Earth
(zoom, pan, tilt, rotate, etc) can be done.
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TIPS FOR GETTING THE MOST FROM GOOGLE EARTH

There are a few options that will enhance your use of Google Earth as a display for SignalTrack.

» In the Google Earth View menu make sure the Side Bar item is checked. This will display the
layers and places windows as shown below. In the Layers window you can select which layers
you would like to have visible. In general, Roads, Borders and Labels, and in some instances
Terrain provide adequate information. In the Places window you can double click on any place
and Google Earth will zoom to it. This is useful for when Google Earth is initially started.

¥ Layers

= M= primary Databass
A Geographic Web
- PIE= Rosds
O 30 Buidings
=0 Street View:
P Borders and Labels
= O R atfic
O ‘ﬁ* Weather
D\v';" Gallery
D@ Global Awareness
O F Places of Interest
O More
- O Terrain

¥ Places

Figure I 1: Layers Window Allows You to Select the Map Layers to Display & O vy risces
& sichtzeeing
Select this folder and click on
the 'Play' button belovwe, to start
B P53 Temporary Places
@ SignalTrack

Figure |2: The Places Window Shows the Data Added to the Map by SignalTrack

» Select Options from the Tools menu to display the 3D View options Tab as shown below. To
avoid cluttering up the map we suggest you select small for the Label size.
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2] x]

30 Vieww | Cache I Touring I Mavistion | General I
i Texture Colors —&nisotropic Fitering—— | Labelsdcon Size Craphics Mode

= High Color (16 kit) @~ Off * Small {* OpenGL

% True Color (32 hit) © Medium  Medium i Directy

¥ Compress " High ) Large ™ Usa sate mode
—Show LatilLong — Show Elevation —Fant

{~ Decimal Degrees & Feet, Miles

{+ Degrees, Minutes, Seconds
" Degrees, Decimal Minutes

" Universal Transverse Mercatar
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Primary 30 fort |
Secondary 30 fort |

— Terrain Guiality

Lowver 1 Higher
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Elevation Exagmeration: |1 (0.5-3)
— Overview: Map
Map Size: Srmall _: Large
Zoom Relation: [infinity 11 J 1:infinity
Restore Defaults | Ok | Cancel | Apply |

Figure 13: Use the 3D View Tab to Set the Label Size to Small

Maps

» Selecting the Cache tab will display the dialog shown below. The cache memory sizes can be
selected to enhance the performance of Google Earth with SignalTrack. The Memory Cache
size is automatically selected by Google Earth based on size of the computer's RAM. If you wish
to use ESRI maps with Google Earth it may be necessary to reduce the Memory Cache size.
Some experimentation may be required to arrive at an optimum setting. Setting this value too

high will cause SignalTrack to run extremely slow. Setting it too low will cause Google Earth

zooming and panning to be sluggish.

The Disk Cache size can be increased to spool a larger portion of the map to disk. In general
we suggest this Cache be set to the largest value that is allowed by Google Earth which is 2000
megabytes. Once this is set, you can disconnect your computer from the Internet and continue
to use Google Earth (Do not close SignalTrack or Google Earth or all the cache memory will be

lost.)
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& Google Earth Options

Figure 14: The Cache Memory Can be Set to Enhance the Performance of Google Earth

»  When quitting Google Earth it will ask you if you want to save the temporary places that were
created by SignalTrack. Always answer No.
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Chapter 4
USING SIGNALTRACK

In this chapter you will learn how to setup and operate SignalTrack

IN THIS CHAPTER
Setting UP SigNalTrack .......cocceveeeereremeeeeeeceneeressensenseseseeesessessessessessesseseens 35
RUNNING SigNalTIaCK ...ttt seaeesene 73
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SETTING UP SIGNALTRACK

SignalTrack can be used to control and monitor a single direction finder or any number of fixed and
mobile sites. In this section you will learn how to

4
4
4

Use the Configuration Wizard to initially configure the program
Add and remove map files for use in displaying the bearing data

Configure SignalTrack to accept data from fixed sites via telephone, Ethernet, or direct serial
connections

Define a list of frequencies (channels) that can be easily selected from a drop down menu

Configure SignalTrack to accept data from other fixed and mobile sites running the SignalTrack
application

Configure SignalTrack to provide data to another site running the SignalTrack application
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USING AN AOR AR5001D

SignalTrack will work with an AOR5001D; however, some addional configuration of the receiver and
the direction finder is required. The receiver baud rate must be changed to 9600 baud and the
communications port on the direction finder must be changed to 9600 baud.

AORS500ID

» Press the FUNC key followed by the MHz key
» Use the Down button to scroll down to BPS
» Turn the knob on the lower right of the receiver until the rate reads 9600

» Press the MHz button.
DDF 6001

» Launch WinRDFCommand and connect to the direction finder per the WinRDFCommand
instructions.

Once connected change the Port 2 radio button control to AOR RX.
Next use the Port Parameters menu to set the baud rate to 9600

Quit WinRDFCommand

v v v WV

Before running SignalTrack make sure the AOR AR5001D is connected to serial port
connector J2 on the back of the DDF 6001.

DDF6002

Launch AutoDFTest and connect to the direction finder per the AutoDFTest instructions
Once connected go to the Port 4 menu and change the baud rate to 9600.

Quit AutoDFTest

v v v WV

Before running SignalTrack make sure the AOR AR5001D is connected to serial port
connector J12 on the back of the DDF 6002.

CONFIGURATION WIZARD

After installing SignalTrack, connect the direction finder, receiver, and any networking components
required to network in other sites (if needed). Power up all components and then launch
SignalTrack. The first time you launch SignalTrack the Configuration Wizard will automatically start.
The options selected during this process will configure SignalTrack as a Network Control Site (NCS),
a fixed site direction finder, or a mobile direction finder.

The first dialog to be displayed is the New Mission dialog. Select Blank Fixed Site Mission if you are

configuring a Network Control Site or a fixed sit with a single direction finder. Select Blank Mobile
Site Mission if you are configuring a mobile site.
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New Mission

Figure 15: Use New Mission Dialog to Select the Type of Site You Want
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NETWORK CONTROL OR FIXED SITE

After pressing Blank Fixed Site Mission, the following dialog will appear

Fixed Configuration Wizard |

Select the map files
you want to use

Load Map Files |

==HEnayviaus Mext=>

Figure 16: Press Load Maps and Select All the Maps You Will Be Using

Press the Load Map Files button and load using the standard file dialog select the maps you are
going to use. You can always add or delete maps or change the map menu at a later time using the
Map Menu Builder. However, it will be helpful to at least load one map that contains the fixed site

locations you wish to use. After you loaded the maps, press Next and the following dialog will
appear.
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Enter channel frequencies and names

%]

Frequency | Name

<<Previous

Finish

Figure |7: Enter any Frequently Used Frequencies

Using SignalTrack

Enter the frequency and name of all channels that you may frequently monitor and press Finish. Itis
not necessary to enter any channels at this time. Channels can always be added later using the

Channels menu.

After you press finish a Save As dialog will be displayed. Type in a name for the mission and press

Save.

After saving the mission file, the Site Editor (see "Fixed Sites" on page 45) will be displayed allowing

you to enter the fixed site information.
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MOBILE SITE

After pressing Blank Mobile Mission the following dialog will appear

Mobile Configuration Wizard I_

Figure 18: Select the Serial Port that is Connected to the Direction Finder

Select the serial port that the direction finder is connected to and press Next. The following dialog
will appear.
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Mobile Configuration Wizard

Figure 19: Select the Receiver You Are Using

Select the receiver you are using and if you are using an ICOM 8500 select the CIV address of the
receiver. (4A Hex is the factory default CIV address.) Press Next and the following dialog will
appear

Fixed Configuration Wizard I_

——
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Figure 20: Press Load Maps and Select All the Maps You Will Be Using

Press the Load Map Files button and load using the standard file dialog select the maps you are
going to use. You can always add or delete maps or change the map menu at a later time using the
Map Menu Builder. However, it will be helpful to at least load one map that will display your
current location. After you loaded the maps, press Next and the following dialog will appear.

Fixed Configuration Wizard |

Enter channel frequencies and names

Frequency | Name

<<Previous Finish

Figure 21: Enter any Frequently Used Frequencies

Enter the frequency and name of all channels that you may frequently monitor and press Finish. It is
not necessary to enter any channels at this time. Channels can always be added later using the
Channels menu.

After you press finish a Save As dialog will be displayed. Type in a name for the mission and press
Save.

If you have a compass installed, shortly after pressing Save you should see a triangle appear on the
map near your present location. The exact amount of time it takes to display your location will
depend on the convergence time of the GPS receiver which can be a few minutes depending on your
location and weather conditions. If you do not have a compass installed it may be necessary to drive
a short distance to allow the GPS to establish a heading. If after a short time you do not see your
position displayed go to the Trouble Shooting section.
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MAPS

The first step in setting up SignalTrack is to decide what maps and/or map data are needed to cover
the desired area. If the area you are covering is large, then you may want to use more detailed maps
of smaller areas within the larger map or use the ESRI ArcGIS Mapping Engine. To select the
maps to use choose Map Menu Builder... from the Maps menu. The dialog shown below will be
displayed. This dialog allows you to build a map menu that contains categories and maps. A category
is simply a name for a group of maps and maps under the category will be displayed in a hierarchical
fashion.

To add a category select New Category from the Add menu or right click on the dialog and select
Add New Category. To add maps to the category, use the mouse to click on the category and
then select Map.. from the Add menu. A standard Open File dialog will appear. Navigate to the
directory (folder) where you saved your maps when you created (see "Creating Maps Using
MapFix" on page 9) them. Select all the maps you wish to use from that directory. (Use CTRL+left
mouse click to select multiple maps). Press OK and the maps will be added to the category.

Similarly, maps may be added at the top level by clicking off of a category and selecting Maps... from
the Add menu.

To delete maps from the menu simply select the map or category you wish to delete and press the
delete button or right click on the map or category you wish to delete and select Delete from the
pop up menu.

x|

t 1 =& Add-X

Ok | Cancel |

Figure 22: Map Menu Builder Dialog

A populated map builder dialog and the resulting menu are shown below. Maps and categories may
be moved up or down to change the order of the maps in the menu or you can simply select a map
or category and drag and drop it in the position on the menu where you want it.
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Figure 23: Populated Map Menu Builder Dialog
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If the ArcGIS mapping engine is installed and licensed, maps may be added to the map menu by
selecting Open ESRI Map or New ESRI Map from the File menu.
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FIXED SITES

Fixed sites may be connected to SignalTrack via a serial port, a telephone modem, or an intranet or
Internet connection. For information on the equipment and connections required at each individual
site see Networking Direction Finders.

SignalTrack requires information about the sites to collect data and display the bearing data. To
enter this information select Site Editor... from the Setup menu. The following dialog box will be

displayed.
SiteEditor

Done New.. Delete

Figure 24: Blank Site Editor Dialog

To add a site use the mouse to push the New button. The following dialog box will be displayed.

Newsite x|
Site Mame  |Doppler

Site Type —————————————
((" Palled  Modem

 Direct Serial & Ethernet

Cancel |

; o Type in the name you would like to use for the site and select the method
Figure 25: New Site Didlog  that will be used to communicate with the site.

» Polled sites are for use by customers using our now discontinued serial expanders

» Select Direct Serial if the direction finder for this site is connected directly to the computer's
serial port or is connected via a dedicated leased-line modem

» Select Modem if the site is to be connected by modem

» Select Ethernet if the sites is to be connected via an Ethernet connection

Press OK and one of the three dialog boxes shown below will be displayed.
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Site Editor I

Doppler | Peoria |
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Figure 26: Site Editor for Telephone Modem Connected Site
Enter the data for each site as follows
» Site location can be entered by manually entering the latitude and longitude of the location or by

moving the mouse from the Site Editor dialog and clicking on the location on the map. The
location can always be moved by left clicking on the site and dragging it a new location

» Use the drop down list to select the receiver you will be using at the site. If you are using a
PCR 1500 you must install the drivers for this device prior to using it in SignalTrack (see the
PCR 1500 documentation for instructions on how to install the driver).

» The CIV address of the direction finder and the receiver. The CIV addresses are physical
addresses of the direction finder and receiver for each site must be unique across the entire
network. These addresses are set prior to deploying the direction finder and receiver to the
site. See direction finder networking for more details.

» Select the color you want to use for the site, the width of the bearing line to be drawn for the
site, and the size of the site

» The Slave ID is only used if SignalTrack is providing data to another site running another version
of SignalTrack via radio modem.

» For direct serial connections select the COM port the direction finder is connected to.

» For modem connections specify the COM port where the originating modem is connected, the
telephone number of the site, and any specific set up string required by the modem. The default
setup string is for the MutiTech DSVD modem.

The phone number can contain any of the following characters
0-9

P to indicate pulse dialing is to be used
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T to indicate tone dialing is to be used

, to force a pause (usually used after an access number)

* tone dialing only

# tone dialing

A-D special characters
( separates numbers

) separates numbers

- separates numbers

» For Ethernet connections, enter the IP address and the port to be used for the connection or
select the URL radio button and type in the URL of the site. If DigiOne devices are used to
connect the direction finder to the network, the default port is 2101.

» Ethernet connections can use UDP or TCP. In cases where network latency is sporadic UDP
usually provides more timely data. If UDP is used then the server (DigiOne) must be
programmed to act as a UDP server (see networking manual).

» If the fixed site has device such as a Barix Instreamer to stream audio to the site select the
Monitor Audio checkbox to enable audio monitoring of this site.

Continue setting up sites as described above until you have data entered for all the fixed sites in your
network and then click the Done button.

CHANNELS AND SCANNING

SignalTrack can save specific frequencies as channels and perform a rudimentary scan of the channels.
Additionally, SignalTrack can be used to set up and scan receiver memories for the ICOM R8500 and
the AOR AR5000 receivers. This section will explain how to save channels and how to set up
frequency scans.
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CHANNELS
In SignalTrack frequently monitored frequencies can be defined to allow the operator to easily tune
the network to a desired frequency. These frequencies are displayed under the Channels menu.

Channels can be added to the menu by selecting Edit Channels... or Load Channel Group...

Selecting Edit Channels... displays the dialog shown below

x

Frequency | Mame Enabled

72

Delete Ok Cancel |
4

Figure 27: Channel Data Entry Dialog

To add a channel simply type in the frequency and name of the channel (the name will default to the
frequency if it is not defined). Select the Enabled check box to display the channel in the menu.
The figure below shows a filled out Channels dialog.

x

Frequency | I ame Enabled | Priority
Phoenis W v

W r
146,94 Wwihite: Tanks W r
147.08 Thompson Peak W r
162.425 Payson W v r
r r

Figure 28: Example of Channels Dialog with Channel Names and Frequencies

Click Priority if you want to specify a frequency that you want to monitor most of the time. If the
operator tunes off of the priority frequency SignalTrack will tune the network back to the priority
frequency after a user selectable time (see "Timing Options" on page 67).
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Click Ok and the list of enabled Channels will appear in the menu. To remove a Channel from the
menu select Edit Channels... and either uncheck the Enabled box or select the Channel name and
press Delete.

SignalTrack can store and retrieve Channel data in comma separated variable (.csv) files. To store
the Channels currently displayed in the Channels menu, select Save Channel Group... A
standard Save file dialog will appear the file can be saved anywhere on the hard drive. To retrieve a
stored set of Channels, simply select Load Channel Group... and select the file containing the
channels.
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SCANNING SAVED CHANNELS

When using SignalTrack at a fixed site or at a Network Control Site, it can be programmed to
perform simple channel scanning. To enable scanning select Options from the Setup menu and
press the Scan tab. Check the Time to monitor channel during scan check box and then
select the type of scan you wish to use. Two types of scanning are available. The first option is to
set a time to dwell on a channel while a bearing is being displayed (see timing diagrams below).
When this setting is used SignalTrack will monitor channels that have no signals on them for the time
set in the Time to monitor channel during scan and monitor channels with signals for Time to
dwell on channel when receiving bearing. If the second option is selected, SignalTrack will
monitor channels that have no signals on them for the time set in the Time to monitor channel
during scan and will continuously monitor the first channel with a signal on it until the signal
disappears and the Time to linger on channel after signal disappears elapses. The channels

that are scanned are the enabled channels as setup in the Edit Channels (see "Channels" on page
49) dialog.

Times | Displa'_.rl Radio Mndeml Hemntesl Slave I I_Dggingl F‘Iaﬂ_.fl:uackl Enu:r{,rptiu:unl
Scan |Nert Sounds I f-‘u:lministlah:url

¥ Time to monitar channel during scan

Lad
(=]

* Time to dwell on channel when receiving bearing 10 5

™ Time to linger on channel after signal disappears I 10 5

Figure 29: Scan Setup Dialog
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Figure 30: Dwell on Channel for a Fixed Time
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Figure 31: Scan Lingers on Channel after Signal Disappears
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SETTING UP RECEIVER MEMORY

If you are using an AOR5000 or an ICOM R8500 receiver, you can use the receiver to scan a
number of frequencies and direction find on a signal found by the receiver. Both receivers have a
number of memory locations organized in banks. The ICOM receiver has 20 banks with 40 channels
each, the AOR receiver has 10 banks with 100 channels per bank.

To set up a receiver for scanning from SignalTrack you must first select a control site. The
frequency that the control site is tuned to will determine the frequency the network will monitor.
When the control site detects a signal, SignalTrack reads the frequency of the receiver and then sets
the frequency of all the sites on the network to the control site frequency. This feature can be used
when the receiver is scanning or it can also be used when a local operator is manually tuning the
receiver. To set the control site select the RX Memory->Control Site from the tool bar as
shown below

R Memony - M3 14" 25714 Ww112° 28' 7.00"
‘ Control Site 3 | Peaoria

Edit R Memaries... Doppler

- T

Scan ] Maone

T

Figure 32: Select the Site You want to be the Control Site

Once you've selected the control site you can either scan memory banks that have been previously
programmed into the receiver or you can program the receiver memories.

To program the receiver memories, select Edit RX Memories from the RX Memory tool bar
dropdown menu. The following dialog will be shown.
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Figure 33: Read or Program the Receiver Memory Banks Using this Dialog

If you want to program the memories manually select the memory bank you want to program from
the Memory Bank dropdown list and then click the Upload from RX button. SignalTrack will then
upload the frequencies from the receiver and you can then modify them. Once you've made the
modifications press the Download to RX button to program the selected memory bank. You can
save the frequencies in the memory bank by pressing the Save or Save As button.

You can also program the memory banks by saving the frequencies in a .csv formatted file. The
format of this file is extremely important and example files that can be used for templates are
provided in the My Documents->Doppler Systems->SignalTrack directory. Once you've
saved the file, you can load it into SignalTrack by pressing the Load from file button. Once the file is
loaded select the bank you want to program and press Download to RX. After downloading you
can modify any of the frequencies and download the modifications.

54



Using SignalTrack

MOBILE OPTIONS

The general mobile options dialog is shown in the Figure below.
- COM port. Select the serial port you have connected the direction finder to.

- Receiver. If the ICOM Receiver box is checked AutoTrack tries to communicate with the
receiver using CIV. The CIV address of the receiver must match the value in RX Addr drop down
combo box. If you are using an AOR receiver with a RS-232 connection you can simply plug in the
AOR receiver into one of the serial ports on the DDF6002 or DDF6100. If you are using an ICOM
PCR 1500 receiver you must install the drivers for the receiver on the PC prior to using SignalTrack.
The PCR 1500 manual contains instructions for installing the drivers.

- Enable AutoScroll. When AutoScroll is enabled the map will automatically scroll as specified in
the AutoScroll options.

- AutoScroll Options. AutoScroll Options allows you to select how the current position and
estimated RF source location are displayed.

If Keep Current Location on Map is selected, Auto Track attempts to keep both the current
active site and the estimated position of the RF source on the map. If it cannot keep both of them

on the map it will keep the current location on it.

The Keep Estimated Source Location on Map behaves the same as Keep Current Location on
Map except that if both locations cannot be displayed on the map the Estimated position is displayed.

The Keep Current Location centered on the Map option forces the current location to be
centered on the map and as the vehicle moves, the map moves and the location stays centered.

The Keep Estimated Location centered on the Map option forces the estimated location to be
centered on the map.

- Center Bearing Display on Active Site. If this check box is checked the bearing display will
move with the active site as it moves on the map. See Displaying the Direction Finder Bearing.

- Disable Compass. This check box disables the compass if it is installed.
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A
NETWORKING MOBILES

Figure 34: Options for Mobile Site

Networking mobile direction finders to the Network Control Site requires either an Ethernet
connection and cellular modems in each mobile or a radio modem connected to one of the
computer's serial ports and each mobile has a DDF6002 based direction finder system and a radio

modem.
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USING A RADIO MODEM

The radio modem at the Network Control Site and the mobiles must be tuned to the same
frequency. SignalTrack acts as the master controller to transmit data from SignalTrack to the
mobiles and to coordinate the response from the mobiles so that no two mobiles transmit at the
same time. The networking section contains further details on networking mobile sites. To enable
SignalTrack at the Network Control site to manage these connections, first select Options... from
the Setup menu and click on the Radio Modem tab as shown below.

Scan | Alert Sounds | Admlmstratorl
T\mesl D\splayl Sites Radio Modem |Remotes| Slave I Loggingl Playbackl Encryptionl

COM Port Freq Band
M| Enabled [COMT | |vHF =]

Pollinglnterval(s)l 5 S|mTime(ms)| 300

" Allow Remotes to Change Network Frequency

Figure 35: Enable the Radio Modem to Communicate With Networked Mobiles and Remote Sites

Click the Enabled check box and select the radio modem COM port. Enter the frequency band
used by the radio modem. The Slot Time is the time allocated for each mobile site to transmit its
data to the network control site running SignalTrack. Increase this time if you are experiencing data
loss from the mobiles. This may happen if you are using radio modems that have significant setup
times. The Polling Interval defines the amount of time between pulses used to trigger mobile
transmissions when direction finding within one octave of the radio modem frequency. This allows
the user to use the direction finder on the same band as the radio modem. If the frequency of the
direction finder network is greater than one octave away from the radio modem frequencies then
SignalTrack queries the mobiles for data as fast as possible.

Normally the Network Control Site is manned and is the controller of the frequency that the
network is tuned to. The mobiles can request a frequency change but the Network Control Site
operator must acknowledge and accept the request. However, in some instances you may want to
allow a mobile site to control the frequency. To allow a mobile to have control of the frequency,
check the Allow Remotes to Change Network Frequency check box. When this option is
enabled any mobile or other remote site in the network may change the network frequency.

To enable SignalTrack in the mobiles to send data to the Network Control site you must configure
SignalTrack as a slave as discussed below.

The system has been tested using DataRadio IntegraTR radio modems which are recommended for
use with this system.
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USING A CELLULAR MODEM

To use a cellular modem simply set up the Remote monitoring in the same fashion as you would to
monitor a site using the Ethernet.

CALIBRATING THE COMPASS

Prior to using SignalTrack in a mobile site it is recommended that you calibrate the compass. After
you mount the roof pod to your vehicle it is important to calibrate the compass to the magnetic
environment of your vehicle. Prior to calibrating the compass make sure you are in a clear area away
from any magnetic materials and that you can drive your car in a circle. With the program in the off
mode, select Calibrate Compass from the Setup menu. The program will instruct you on the
required maneuvers and data entry required to complete the calibration.

Note: A compass is not required to use SignalTrack; however, if a compass is not used the vehicle must be
moved dfter SignalTrack is put in the run mode so that the GPS receiver can calculate a heading.

SETTING UP THE GPS

A GPS receiver is used in the mobile configuration to provide the location of the mobile site.

A GPS receiver can also be used to synchronize the time base within SignalTrack to the GPS
messages. This is particularly useful if you have multiple sites running SignalTrack and you want the
logged data to agree at all the sites in the network. This feature can be used in either a fixed or
mobile configuration. See Timing Options (on page 67) to learn how to enable this feature.

The GPS receiver used must provide ONLY the standard GGA and VTG messages at a rate of once

per second. The DDF6074 is factory programmed to provide these messages. If you use a different
GPS receiver you must program it to provide these messages.

ACCEPTING DATA FROM ANOTHER SITE RUNNING SIGNALTRACK

SignalTrack can accept data from another site running the SignalTrack application. The site can be
linked into SignalTrack via radio modem, telephone modem, or via an Internet or intranet TCP/IP
connection.

RADIO MODEM

Follow the same instructions as was given for setting up Mobile Networking (see "Networking
Mobiles" on page 56) to link another fixed site into SignalTrack using a radio modem.
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Select Options from the Setup menu and click on the Remotes tab. The dialog shown below will be
displayed. For each site that has a telephone modem or leased line modem select the Enable check
box and select the COM port that the modem is connected to. The SignalTrack application
supplying (see "Providing Data to Another Site Running SignalTrack" on page 62) data will

originate the modem connection.

Scan I Alert Su:uundsl .ﬁ.dministraturl
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™ Enable Audio Monitoring  Port 2104
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Figure 36: Enable Remotes to Allow Other Sites Running SignalTrack to Connect to SignalTrack

Using SignalTrack
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TCP/IP OR UDP/IP(ETHERNET)

Select Options from the Setup menu and click on the Remotes tab. The dialog shown below will be
displayed. Click the Enable TCP/IP check box and enter the port that you would like to use for the
connection. SignalTrack provides a server connection allowing the other SignalTrack application
supplying (see "Providing Data to Another Site Running SignalTrack" on page 62) the data to
initiate the connection.
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Figure 37: Enable Remotes to Allow Other Sites Running SignalTrack to Connect to SignalTrack

In cases where network latency is sporadic UDP can deliver data in a more timely fashion than UDP.
Typically this is the case when using cellular modems for remotely monitoring mobile sites. If you
are using a cellular modem select Enable UDP/IP.

SignalTrack has the ability to monitor and record audio sent from remote sites where each remote
site has a device such as a Barix Instreamer to digitize and send the audio. If you want to monitor
the audio check Enable Audio Monitoring and type in the IP port that the remote sites will be
streaming the audio to.

60



Using SignalTrack

PROVIDING DATA TO DF NETWORK MONITOR

DF Network Monitor is a utility program provided by Doppler Systems, LLC that enables a central
location to monitor multiple networks. Each network consists of one or more Doppler Systems
direction finders that are control by a computer running SignalTrack. To enable DF Network
Monitor to connect with SignalTrack, select Options from the Setup menu and select the

Remotes tab. The dialog shown below will be displayed.
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Figure 38: Enable Remotes to Allow Other Sites Running SignalTrack to Connect to SignalTrack

Check the Enable Remote Network Monitoring check box and enter the IP Port and
Network Name. After you've completed this step DF Network Monitor can connect with

SignalTrack and display the bearing data gathered for each site.
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PROVIDING DATA TO ANOTHER SITE RUNNING SIGNALTRACK

SignalTrack can be configured to supply data to another site that is running SignalTrack. A fixed site
may provide data via a telephone modem, an Ethernet connection, or a radio modem. A mobile site
supplies data using a radio modem. When it is in this mode it is referred to as a slave since the
application it is connected to controls the frequency of the sites. To make SignalTrack a slave, select
the Slave tab in the Options dialog.

Adrninigtrator I
Times I Dizplay  Slave |Lu:ugging| F'Iayl:uac:kl Enu:r_l,lptinnl Scan I .&IertSDundsI
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Slave Connection |
" RadioModem & TCPAP & UDPAP  Diect Seral Telephu:unel
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™ URL

CONFIGURING A
Figure 39: Enable the Slave Property to Supply Data to Another SignalTrack Location NETWORK CONTROL

SITE AS A SLAVE

Check the box Make SignalTrack Supply Data To Master, type in a name for the slave, and
then select the method you want to use to supply the data.

If you select Radio Modem, select the serial port that the radio modem is connected to. The
program will prompt you to assign site ID numbers to each site using the Site Setup (see "Fixed
Sites" on page 45) dialog. The ID's you assign must be unique to any other mobile or radio modem
connected slave sites on the network.

If you select TCP/IP the program will prompt you to enter the IP address or URL and port of the
site you want to connect to.

If you select UDP/IP enter the IP address or the URL and the port number of the site you want to
send the data to.

If you select Telephone you will be prompted to enter the telephone number of the site you want
to connect to.

CONFIGURING A MOBILE AS A SLAVE
If you are using a radio modem, check the box Make SignalTrack Supply Data to Master and

select Radio Modem. Type in the ID number of the slave. Each slave on a radio modem linked
network must have a unique ID between | and 255.
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If you are using a cellular modem select UDP/IP and enter the IP address or the URL and the port
number of the site you want to send the data to.

RECORDING A LOG FILES

SignalTrack can record the data that it receives into text files. To enable the recording of log files,
select Options... from the Setup menu and press the Log tab.
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Figure 40: Enable Logging to Create Text Based Log Files

Click the Enabled checkbox and then select the folder you want to save the playback files in. The
default directory is My Documents->Doppler Systems->SignalTrack->Log. After enabling
logging select the data you want to log by checking the appropriate check boxes. In the File
Preference box, click New file for each day if you want all the data for a single days run placed in
a single file. Press New file for each run if you want SignalTrack to make a new file each time the
Run button is pushed. Press New file for each frequency if you'd like SignalTrack to make a new
file each time you change frequency. If you elect to have a new file for each frequency, a folder for
that frequency will be created within the folder you selected above and the file will be in that folder.
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RECORDING PLAYBACK FILE

SignalTrack can record the data that it receives so that it can be played back. To enable the
recording of the playback files, select Options... from the Setup menu and press the Playback tab.
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Figure 41: Enable Playback To Record Files to Be Played Back Later

Click the Enabled checkbox and then select the folder you want to save the playback files in. In the
File Preference box, click New file for each run if you want SignalTrack to make a new file each
time the Run button is pushed. Press New file for each frequency if you'd like SignalTrack to
make a new file each time you change frequency. If you elect to have a new file for each frequency, a
folder for that frequency will be created within the folder you selected above and the file will be in
that folder.

MONITORING AND RECORDING AUDIO FROM REMOTE SITES

SignalTrack has the ability to monitor and record audio from remote sites. The following steps are
required to enable the audio recording option.

1) Select Setup->Options and then select the Remote tab and check the Enable Audio
Monitoring checkbox (see "Accepting Data From Another Site Running SignalTrack" on
page 58).

2) Select Setup->Site Editor and check the Monitor Audio (see "Fixed Sites" on page 45)
checkbox for each site you want to monitor the audio on.
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When the run button is pressed, SignalTrack will play the audio being received from one of the sites.
You can use the Audio Monitoring dialog to select which site to listen to and to set audio

monitoring options. To display the Audio Monitoring dialog select View->Audio Monitoring to
display the dialog shown below.
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To change the site you are monitoring select the site name from the
Figure 42: Audio Monitoring Dialog = gj¢e dropdown list.

The received audio from all sites will be recorded if any one site breaks the squelch setting. In most
cases the default setting will suffice provided that the receivers at the remote sites squelch when no
signal is on frequency. However, the squelch setting can be changed by adjusting the squelch level.

The Options menu can be used to adjust the Buffer time and the Squelch time. The Buffer time is
the time that SignalTrack receives audio before playing it. The buffer time results in a delay in the
audio and a small value is best; however, in some instances where the network has sporadic latency it
may be necessary to increase the buffer time as shown below
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Figure 43: Setting the Audio Monitoring Buffer Delay

The Squelch time is the time SignalTrack keeps recording after the audio on all the channels drops
below the squelch level. To adjust this time select Option->Squelch Time and select the time you
would like to use as shown below.
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TIMING OPTIONS
Use the Times tab in the Options dialog to set the program timing.
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Figure 44: Adjust the Response Times if You are Getting Frequent Timeout Messages

The Polling Time sets the time used to Poll direction finders that are connected to a Doppler
Systems Serial Expander. This is included for legacy systems but is not recommended for new
installations.

The Time to wait for a DF Response sets the time the program will wait for the direction finder
to respond to a command.

The Time to wait for RX Response sets the time the program will wait for the receiver to
respond to a command.

The Time to wait for IP Response sets the time to wait for a site connected via Ethernet to
respond to a command.

The Timeout Interval for Remote Sites sets the time the program will wait before notifying the
operator that a mobile site or remote site has not responded to a poll command. Enter 0 if you do
not want SignalTrack to alert you when site has not responded.

The Off priority channel time is the maximum amount of time that SignalTrack allows the
network to be off the priority channel frequency if the priority channel (see "Channels" on page
49) feature is enabled.

You can display the time in the tool bar in either 12 or 24 hour format by selecting the radio control
in Time Display.

If you want to synchronize the local time with a GPS receiver select the Use GPs for Local Time
option. If you are operating SignalTrack in a fixed site manner you will need to connect a GPS
receiver to the appropriate serial port on the computer. If you are using a SignalTrack in a mobile
site the GPS connected to the direction finder will be used.
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ENCRYPTION

The messages sent between SignalTrack and any direction finding site with a computer can be
encrypted if desired. Encryption is enabled and disabled by use of the Encryption tab in the
Options menu. The default condition is encryption off.

To enable encryption select Options from the Setup menu and click on the Encryption tab. The
following dialog will be displayed
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Figure 45: Enable Encryption by Entering the Password

Enabling or disabling encryption requires a password. To obtain this password you will need to
contact the factory (davec@dopsys.com). When you've obtained the password type it in and press
the Enter key. Once you've entered the password, the controls on the dialog will be active. Press
Change to change the password. Select the Encryption Method you want to use to enable
encryption. Once encryption is enabled, you must enter an encryption key. This key must be 16
characters long for AES encryption and 7 characters long for DES encryption. Any series of
characters is acceptable.

Note: When encryption is enabled all remote sites communicating with SignalTrack via a computer must use
the same key or the encryption will fail.

The dialog shown below is an example of the dialog with encryption enabled.
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Figure 46: Enabled Encryption Options Dialog

70



Using SignalTrack

ALERT SOUNDS

If a fixed site is no longer responding, SignalTrack will alert the user by displaying the dialog box
shown below.

Receiver Communications Error m

Receiver at Peoria did not respand to the last Set Frequency command.
Would you like to resend the command

feg Mo |

Figure 47: SignalTrack Displays the Dialog if a Site is not Responding

If you press no, the site will be displayed as a cross hatched square. After this happens, the operator
can be further alerted that the site is down by means of an optional alert sound. To enable an alert
sound select Options from the Setup menu and press the Alert Sound tab. Check the Play
alert sound after an enabled site is down for box and then select the sound file you would like

to play and the how often you would like it played. Two sample sounds are supplied in the
SignalTrack installation.
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Figure 48: Alert Sound Options
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ADMINISTRATOR

In some cases when SignalTrack is configured as a network control site, you may want to inhibit an
operator from making changes to the setup of SignalTrack. You can do this by setting up an
administrative password. Select Options from the Setup menu and press the Administrator tab.
Check the Enable Administrator check box. When you check it you will be prompted to enter a
password. This password will be required to make changes to any of the items that are checked in
the box. For instance, if Site Editing is checked then the user will need to enter the password to
change the location of the site or any of the site parameters.

The Revert To Default Settings can be used to reset all SignalTrack options to their default
values. If Enable Administrator is checked a password will be required to reset the settings.
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Figure 49: Enable the Administrative Password to Inhibit Changes to the SignalTrack Setup
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RUNNING SIGNALTRACK

SignalTrack is now ready to collect data from the sites that are connected to it and display this data
on the map.
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TRACKING AN RF SOURCE

NETWORK CONTROL SITE

Once SignalTrack is configured, use the mouse to press the Run button . If radio modem
networked sites (fixed or mobile) are on the network, the SignalTrack at the Network Control Site
will begin sending poll messages to them. When each site receives a poll it registers itself with
SignalTrack. Once registered SignalTrack begins collecting data from these sites.

If fixed sites use telephone modems, pressing the Run button causes the originating modems to call
each of the sites. If for some reason the site cannot connect with the modem, then an error
message will be displayed.

Fixed sites connected by Ethernet or direct serial stay connected continuously.

The frequency monitored by a network of direction finders will depend on how you've setup
SignalTrack. If you want SignalTrack to control the frequency make sure you've selected None from
the RX Memory->Control Site menu. If you want a receiver at a site to control the network
frequency the select the site name from the same menu.

If you are using SignalTrack to control the frequency, set the frequency by selecting the channel you
wish to monitor from the Channel menu, using the frequency display in the tool bar, or using the
Receiver Control dialog. Selecting the frequency sets the receivers at the DF locations to the
selected channel frequency and begins monitoring the direction finders for bearing data.

If you are using a site receiver to control the frequency, either manually tune the receiver to the
desired frequency or select the memory bank to scan from the RXMemory->Scan drop down
button.

The fixed direction finder sites will be displayed as colored squares on the map (see Figure below). If
a RF source is present at the channel frequency, lines of bearing will be displayed emanating from the
site location. If more than one site is receiving data, the SignalTrack will provide a real time estimate
of the source location and an average estimate of the source location. The estimates are displayed as
small circles. Typically SignalTrack is configured in the Options dialog to display the most current
estimate as well as older estimates. The older estimates gradually fade away as new estimates
become available. The average estimate is displayed in a different user selectable color. Additionally,
an uncertainty ellipse will be drawn. The uncertainty ellipse is calculated using the uncertainty in the
direction finder measurements. Under ideal conditions, the RF source has a 95% probability of being
within that ellipse. The Figure below demonstrates a typical display of the target location.
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Figure 50: Display of a Target Location

When SignalTrack is receiving a bearing from a fixed site the measured bearing and the receiver S
meter reading will be displayed in the Bearing and S-meter display bar near the bottom of the display.

Mobile sites when registered appear as triangles with the head of the triangle pointing in the
direction the mobile is heading and with a small red or gray dot in the middle. When direction
finding within the same band as the radio modems, the amount of time the radio modem is
transmitting is limited (typically once every 5 seconds (see "Networking Mobiles" on page 56)).
Therefore, the data received from these sites is typically spread over the interval between
transmissions. SignalTrack displays each of these bearings bled in over a 400 ms interval (may be
changed in the in the options dialog) and then holds the last bearing received. Each of these
bearings is used to update the estimates made previously by the fixed sites. These updated estimates
are shown in a different color that is selected in the options menu. If the frequency being used is
more than one octave away from the radio modem frequency the polling time is increased so the
estimated locations are updated more frequently. The dot in the center of the site icon changes
color when the site data is received.

Other SignalTrack sites supplying data as slaves appear as diamond shaped sites and their data is
factored into the position estimate.
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Figure 51: Screen Shot of Two Fixed Sites and Two Mobiles
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When using SignalTrack in a mobile installation, the current location will be shown as a triangle with
the point of the triangle oriented in the direction the mobile is heading. To track a signal press the

Run button . After pressing the Run button, set the frequency by selecting the channel you wish
to monitor from the Channel menu, using the frequency display in the tool bar, or using the Receiver
Control dialog. Selecting the frequency sets the receiver to the selected channel frequency and
begins monitoring the direction finder for bearing data. If a RF source is present on the channel
frequency, a line of bearing will be displayed emanating from the site location. A site location and
bearing can be saved on the screen by pressing the Insert key. After a measurement is saved to the
screen, the line of bearing will be used to estimate the position of the signal using all saved locations
as well as the currently active location. Any saved location can be deleted by selecting it with the
mouse and pressing the Delete key. All saved sites can be deleted by pressing Shift + Delete.
Typically SignalTrack is configured in the Options dialog to display the most current estimate as well
as older estimates. The older estimates gradually fade away as new estimates become available.
Additionally, an uncertainty ellipse will be drawn. The uncertainty ellipse is calculated using the
uncertainty in the direction finder measurements. Under ideal conditions, the RF source has a 95%
probability of being within that ellipse.

When the mobile is operated as a slave, the Network Control Site will supply bearing data from the
fixed sites it is controlling. The sites will appear as black squares at the fixed site locations and the
measured bearings will be shown. These bearings are also used to update the estimated position.
The Network Control Site sends all bearings received over the interval since the last time it polled
the mobile site and SignalTrack in the mobile bleeds in this data over a 400 ms time period and then
it holds the last bearing received.

The figure below shows a display with a number of saved bearings and a fixed site.
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TUNING THE RECEIVER

There are three ways to tune the receiver while operating SignalTrack: using the Channel Selector
drop down menu in the toolbar (see figure below), changing the toolbar Frequency Selector (see
figure below), and using the receiver dialog.

If you have entered channels (see "Channels" on page 49) in the Channel menu simply choose the
channel from the Channel Selector drop down menu (as shown below) and the network will be
set to the channel frequency. To use the frequency selector first set the desired tuning step in the
Tuning Step drop down menu, then use the up down arrows or the keyboard arrows to tune the
receiver frequency. You may also type the frequency into the Frequency Selector and hit the
enter key.

/ Channel Selector dropdown menu

Tuning Step dropdown menu
@ @-Emz.munnn T+ Tuesonwx (3 | N33° 08'21.6" W 1120 27'42.0" | 10/7/2007 6:34:23 AM

Frequency Selector \_Receiverﬁ\djustments

Figure 52: SignalTrack Toolbar Receiver Controls Aim i 1EES e e
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Figure 53: Channel Selector Dropdown Menu

To use the receiver dialog, select Receiver... from the Setup menu or press the Receiver
Adjustments tool button and the dialog shown below will be displayed. To change the frequency
you can

» Select the Tuning knob and press the right mouse button to increase the frequency or the left
mouse button to decrease the frequency,

» Select the Tuning knob and press the up arrow to increase the frequency or the down arrow to
decrease the frequency,
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» Type the frequency into the frequency display and press Enter or Tab,

» Press the up or down arrow button next to the MEM button to move the previous or next
channel in the saved channels, or

» Press the MEM button and select the channel you would like to use

The TS button and the arrows to the left of it may be used to set the tuning step or the Tuning
Step drop down button in the tool bar can be used for the same purpose.

The Save button at the bottom of the display can be used to save a frequency as a Channel.

Receiver Control

I Pearia hd I

9 @

Yolume Squelch

B

A [IE] 162.550 Phoenix WX
(W]

SER sz 162.550000
Tune

Figure 54: Use the Receiver Dialog to Tune the Receiver to any Frequency

To adjust the volume or squelch setting of a receiver at a site, select the site name from the drop
down list and then use the Volume and Squelch knobs to make the adjustment. The knobs are

adjusted using the mouse or the up and down arrows in a similar fashion to the Tuning knob (see
above).

The button directly to the right of the site drop down can be used to hide the tuning portion of the
dialog to take up less screen space if desired.
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CALIBRATING TO A BEACON

A beacon is a site at a known location on a known frequency. Signal track can automatically calibrate
the direction finders to a beacon site. When selecting a beacon to calibrate to make sure you have a
strong signal and an unobstructed line-of-site to the beacon. Also, make sure you are in a location
that is relatively free of reflection paths.

ENTERING A BEACON SITE

To enter a beacon site place your mouse at the location where you want to place the beacon. Right
click the mouse and select Add Beacon. Enter the beacon name and frequency. The beacon site
will be displayed as a black circle with a B in the middle of it.

FIXED SITES

SignalTrack can be calibrated by entering a fixed calibration angle or by calibrating to a beacon on the
map. To calibrate to a fixed angle right click on the site and select Calibrate. Next enter the
calibration angle and press Calibrate. To calibrate the fixed site to a beacon, select the sites you
want to calibrate by pressing left clicking the sites with the shift key down. After you've selected the
sites you want to calibrate, place your mouse over the beacon site and select Calibrate To
Beacon. SignalTrack will tune the receiver to the beacon frequency and automatically calibrate to
this beacon. When the calibration is complete SignalTrack will tune the receiver to the original
frequency.

MOBILE SITES

To calibrate the direction finder to the beacon, right click on the beacon and select Calibrate To
Beacon. SignalTrack will tune the receiver to the beacon frequency and then calibrate the direction
finder to point at the beacon. When calibrating to a beacon it is very important that your heading be
accurate. If using a compass, make sure the compass is calibrated and your vehicle is well away
from any magnetic materials. If using the GPS, establish a heading by driving forward slowly in a
straight line.
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MANIPULATING THE DISPLAY

Features of the display can be altered via the View menu and by change the Display options in the
Setup->Options dialog. The figure below shows the View Menu.

Wigw | taps Channel:  Setup  Help

Show Bearing Lines
Show E stimated Pozitions
Show Estimate Elipse

Show Average Estimated Pozition

Dizplay Data...

Zoom In Ctrl +
Zoom Out Ctrl -
Audio Monitor...

Refresh Screen Fa

Foure 55 View Meny  BEARING LINES, ESTIVATED POSITIONS, ESTIMATE ELLIPSE, AVERAGE
'gure oo View et ESTIMATED POSITION

If the Show Bearing Lines item is checked SignalTrack draws a line of bearing from each site
location towards the target emitter. Uncheck this menu item to disable the drawing of bearing lines.
If the Show Estimated Positions item is checked SignalTrack will calculate the estimated position
of the emitter based on the bearing measurements of two or more sites and display them as circles.
If the Show Estimate Ellipse is checked SignalTrack will display an ellipse that under ideal
conditions predicts the emitter has a 95% probability of being within the ellipse. If the Show
Average Estimated Position is checked SignalTrack will display the average of a user selectable
number of position estimates. The number of estimates to use is selected in the Display dialog as
discussed below. The colors of the estimated positions and the ellipse can be set using the Display
dialog as discussed below.

Z00M

You can adjust the zoom level by right clicking on the map and selecting Zoom In or Zoom Out,
typing CTRL++ or CTRL+-, or selecting Zoom In or Zoom Out from the View menu.

DISABLING A SITE

You can disable a site by right clicking on the site and selecting Disable. Data coming received for a
disabled site will be logged (if enabled) and put in the Playback file (if enabled), but it will not be
displayed on the screen.

DISPLAY OPTIONS
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Use the Display tab in the Options dialog to set up some of the display parameters.

Scan | Alert Soundsl Administratorl
Times Display |F|adio Mndeml Hemotesl Slave I Loggingl F‘Ia_l,lbackl Encryptionl
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Mumber of Bearings ta Display 1
Mumber of E stimated Positions Ta Display I 10

zed |n Time [m: I Update Color |

Bleed In Time [ms] 400

IV Hold La = I Average Colo |
st Measured Bearings for a0 s i i

¥ Hold Average Position Estimate for I Jelijars “irtual Sike Color |

ADDING MGRS COORDINATE DISPLAY
Figure 56: Options for Displaying Data

Click the Show MGRS checkbox to display MGRS coordinates.
ENABLING GOOGLEEARTH AS A DISPLAY

Click the Enable Google Earth checkbox to display enable the use of Google Earth as a data
display option.

SELECTING NUMBER OF ESTIMATED LOCATIONS TO DISPLAY

SignalTrack displays the most recent estimate of the targets position and N past estimates. Enter the
number of past estimates in the Number of Estimated Positions To Display dialog box.

SELECTING THE NUMBER OF BEARING LINES TO DISPLAY

In addition to past estimates of the target location, SignalTrack can display the current bearing and N
past bearing lines. Set Number of Bearings to display to display multiple bearing lines.

MOBILE BLEED TIME

The Mobile Bleed Time sets the time it takes to display the bearings collected by the mobiles over
the previous time period as described in Tracking an RF Source (on page 74).

POSITION ESTIMATE COLOR
Press the Estimate Color button the set the color of the estimated target positions. Update
Color sets the color of the target positions after they are updated by receipt of data from mobile or

remote sites connected by radio modem. Average Color sets the color of the displayed average
position estimate.

VIRTUAL SITE COLOR

Press the Virtual Site Color button the set the color of the virtual sites that are added to the
screen.
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HOLD LAST MEASURED BEARINGS

SignalTrack can process and display the measured bearings in two different ways. If the Hold Last
Measured Bearings for item is unchecked SignalTrack will base its estimated positions and display
bearings in a time synchronized fashion. This means that the position estimate is calculated using
bearings that were all measured over a given 0.5 second time interval and similarly the bearing lines
shown are for the identical 0.5 second interval. This setting is useful if you are attempting to locate
more than one rf emitter and one of your sites is not receiving one of the emitters.

If the Hold Last Measured Bearings for item is checked, the previous estimates will be time
synchronized; however, the most recent estimate will be based on the last bearing received at each
site. This setting is useful if you would like to hold the last measured bearing on the screen.
Typically this would be done if mobile sites were part of the network, or if for some reason a
communications delay caused one or more of the sites to receive bearing data. This setting is also
useful if the signal is weak at one site and the bearing readings are sporadic.

In most cases the checking Hold Last Measured Bearings for will give the best results. The time
value sets the amount of time the bearing will be displayed if no bearing updates are received.

The status bar at the bottom of the display will display the bearing measured at the fixed sites
connected to SignalTrack. If the site does not receive a bearing for one second the text will be
italicized.

Hold Average Position Estimate

The Hold Average Position Estimate for check box and time setting works similar to the Hold
Last Bearings for except the parameters apply to the average position estimate.

MOBILE SITE DISPLAY OPTIONS

In the Options dialog you can change the way mobile sites are displayed by pressing the Sites tab.
The following dialog is displayed

General I Times I Display Stes |Slave | Lu:uggingl F‘Iaﬂ_.fl:uau:kl Enu:r'_.fpticunl

— Site: Colors Beacon Ficed Site
1]. Black j E]. Gray j I. Black j I. Black j
2].F""E“j j ?]DH}'EH j Site Size

3]. Blue j E‘]. Birown j | ..1 v|

4].Green =] 5']|:|‘r'elld-.r.' =]
5]|:|D,ran j 1E‘].Fuchsiﬂ j

Figure 57: Mobile Site Display Options
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Each time the Insert key is depressed a new active site is created and the color of the site changes.
Select the sequence of colors using the dropdown comboboxes in the dialog. You can also change
the size of the displayed site. Also, the colors for the fixed site and beacon can be changed.

VIRTUAL SITE

Virtual sites are sites that can be added to the map and the position estimate manually. These sites
would allow mobiles or remote sites that have bearing information but no networking ability with the
network control site to relay the bearing information to the network control site and the operator
can enter it and display it on the map. To create a virtual site, right click anywhere on the map and
select Add Virtual Site from the popup menu. Type the bearing into the text box that pops up
beside the virtual site and press the enter key. To change the bearing value, right click on the virtual
site and select Set Bearing from the popup menu. To delete a virtual site, click on the site to
select it and then press the Delete key.

MOBILE SLAVE OPERATION

When operating as a slave the mobile sites' frequency is slaved to the Network Control Site. The
Network Control Site periodically polls the mobile site to set it to the network frequency and to
instruct it to send data collected since the last poll. Once polling is complete the Network Control
Site sends data to the mobile site to allowing the mobile site to display the location and bearings of
the fixed sites in the network. When the mobile site running in the slave mode a LED button is
displayed in the tool bar as shown below

| ©-

Figure 58: Mobile Toolbar

The LED button has two functions.

It blinks whenever the Network Control Site polls the mobile site. You can use this fact to
determine if you are out of range of the Network Control Site. When you are within range and the
Network Control Site is operational the LED should blink at least once every 5 seconds.

When in the slave mode you can click on the LED button to allow the mobile operator to change the
frequency of the local receiver. When the button is pressed frequency control of the mobile site is
turned over to the mobile operator. The mobile operator can then request a change in the network
frequency by selecting Request Frequency Change from the Channels menu. If the Network
Control site operator accepts the change or the Network Control Site has allowed remote sites to
change the frequency (see "Networking Mobiles" on page 56) clicking on the LED button will
return the mobile site to the slave mode and the frequency will stay the same. If the Network
Control Site rejected the change, the frequency will change back to the previous network frequency.
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TEXT MESSAGING
-0/
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Figure 59: Text Messaging Windows

SignalTrack can send and receive text messages from any remote or mobile site. VWhen a remote or
mobile site registers with SignalTrack a menu item, Text Message, appears in the menu bar. Select
the name of the remote site or Mobiles from the menu to display the text messaging window. All
mobiles have one text messaging window and each remote will have a text messaging window. To
send text to a mobile, enter text into the Send box and press the id number of the mobile you
would like to send the message to. If you want to send the message to all mobiles, press the All
button. To send a text message to a remote site enter the text in the Send box and press Send.
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MOBILE BEARING DISPLAY

In many cases it is convenient to see the direction finder bearing reading (i.e. the bearing relative to
vehicle). This is particularly useful when getting close to the signal source and also can be used to
determine the direction to drive when heading to the source. The bearing is displayed on the front
of the direction finder; however you can also display it on the screen by selecting Show Bearing from
the View menu to display the dialog shown below

A {I; r -
415 45
270 90 —
275 135
r 1?‘{:‘ L3

Figure 60: Use the Slider on the Right to Adjust the Opacity of the Display

When using bit map based maps, adjusting the slider on the right will adjust the opacity of the display
allowing you to see the map through the display. If you adjust the slider to the minimum value the
display will be come transparent and the bearing angle will appear on the map. Right clicking on the
display will display a context menu (shown below) that will allow you to hide the brightness control.
It also allows you the set or reset the Center Bearing Display on Active Site property. When
this property is set the Bearing Display will stay centered on the currently active site. If this
property is not set you can move the Bearing Display anywhere on the screen.

by
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i Close
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Figure 61: Use the Context Menu to Manipulate the Bearing Display
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MISSION DATA

A mission is defined as configuration of SignalTrack at a given time. This includes the maps in the
map menu, the channels, the sites, and all the options in the set in the Options dialog. When
launched SignalTrack will load the last used mission parameters. However, you can also save the
mission parameters and retrieve them at a later time. This feature allows the same version of
SignalTrack to be used on a number of different direction finder networks if desired. It also allows
you to save a working configuration prior to making any changes to the network and then reverting
back to the working configuration if the changes are not working correctly.

To create a new mission select New Mission... from the File menu. The following dialog will be
displayed. Select Blank Mission if you want to start with a blank slate. If you want to use the
existing parameters for the new mission file select Make new mission from existing Mission. A
standard save dialog box will be displayed for you to name the mission file. Selecting either new
mission options will cause the Configuration Wizard to be executed.

T |

| Blank Fixed Site Mission

Make new mission from existing Mission

I
Blank Mobile Site Mission |
Cancel |

Figure 62: Select the Type of Mission You Want to Create

At any point you may save the mission parameters by selecting Save or Save As... from the File
menu. To open a previously saved mission file, simply select Open Mission... from the file menu.
You can also double click on a mission file (*.dop) from Windows Explorer and SignalTrack will
launch with the selected mission loaded.
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VIEWING LOG FILES

When logging has been enabled (see "Recording a Log Files" on page 63) the LogViewer (on page
3) application can be used to view the log file. Select View Log File.. from the File menu. If you
are running and have collected data the latest data collected will be displayed. Data will be pulled
from the existing log file without disrupting the recording of data and a snapshot of the data will be
shown. If you want to look at log files created previously, simply go to the file menu and select Open
Log File... An example of the LogViewer output is shown below.

~1olx
File:

Date Time |Site |Latitude |L0ngitude |Bearing |S |Frequenc:y H
5A5/2007 (0348138125000 Peoria N33 48'01.4" W 111° 57 473" 66 0 162425

5A5/2007 0348133906250  Peoria N33 48'01.4" W 111° 57 473" 67 0 162425
5A5/2007 0348128750000  Peoria  N3Z 48°01.4" W 111° 57 473" 68 162,425
5A5/2007 0348123593750  Peoria  N3Z° 48'01.4" W 111° 57 473" 70 162,425
5A5/2007  03:48:11.8437500  Peoria N33 48'01.4" W 111° 57 473" 70 162,425

BABZ007 0348114218780  Peoria N33 48°01.4" WwW111® B7 473" 67 162,425

o o o o o

BAB/2007 0348109687500  Peoria N33 48°01.4" WwWi11® &7 473" 67 162,425

VIEWING PLAYBACK FILES

To view playback files, select Playback from the File menu. A standard Open File Dialog box will
be displayed. Navigate to the directory you selected (see "Recording Playback File" on page 64)
for your playback files and open the file. Make sure you have placed maps in you map menu that
cover the area that you used when recording the data. Once you've selected the file the playback
control will be displayed.

5
(i

Figure 63: Playback Control Dialog

The buttons on the control and the slider allow you move quickly move around in the file and the
display will match where you are in the file. Press the play key to play the file back in real time.
Press the fast forward button to play the file back at 10 times real time. Use the small arrows to
move forward or back one file record. Use the slider control to quickly move anywhere in the file.

PRINTING

To print what is on the screen simply select Print from the File menu. You may want to press the
Hold button to capture and freeze a display prior to printing.
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SCREEN CAPTURE

A jpeg or gif image of the screen may be captured by selecting Save Screen... from the File menu.

RUNNING SIGNALTRACK FROM THE COMMAND LINE

SignalTrack can be run from the command line and immediately switched into the run mode if
desired. The command line format is as follows:

C:\Program Files\Doppler Systems\SignalTrack\SignalTrack.exe [/R] ["mission file path"]
The /R and mission file path are optional. /R will cause the program to switch to the run mode after

it is initialized. The mission file path will cause the specified mission file to be used. If this is not
specified then the last run mission file will be used.

TROUBLESHOOTING

Most operational problems in SignalTrack can be traced to improper setup of the equipment or the
software. This section will outline some techniques you can use to check your setup and determine
if the equipment is providing the necessary data to SignalTrack
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DISPLAYING SITE DATA

SignalTrack can collect site data using a number of different communications channels. Both TCP/IP
and serial port data can be collected. For debugging purposes it is sometimes helpful to view the raw
data coming in on these channels. To do this select Display Data... from the View menu. This
launches the Data Display application. Use the drop down list in the tool bar to select the channel
you would like to monitor. The figure below shows some typical hex data from a fixed site. The
data can be displayed in HEX or ASCII.

When SignalTrack is acting as a Network Control Site it is best to view the data in the HEX format.
When using SignalTrack in a mobile application both HEX and ASCII formats can be helpful.

Data Display

File
CoM = [[»] | [A]
Sert Received

FE FE 08 EO 05 00 0D 55 62 01 FD ;I FEFEEDDSFBFDFEFE

FEFEDZ2EDOF FD EDD2FBFD FEFEEDDZ 57 41 FD

FEFEDZEDQ3 D4 FD FE FEEDDZ 96 41 FD

| FE FEEDDZ 57 41 FD
FE FE EDOZ 54 41 FD
FEFEEDDZ2 57 41 FD
FE FEEDOZ 52 41 FD
FE FEEDOZ 52 41 FD
FEFEEDDZ 94 41 FD
FEFEEDDZ 52 41 FD
FEFEEDDZ5341FD
FEFEEDDZ 54 41 FD
FE FEEDDZ 96 41 FD
FE FEEDOZ 94 41 FD
FEFEEDDZ 56 41 FD
FEFEEDDZ 53 41 FD
FE FEEDOZ 52 41 FD
FE FEEDDZ 52 41 FD
FEFEEDDZ 55 41 FD
FEFEEDDZ25541FD
FE FEEDDZ 96 41 FD
FEFEEDDZ 54 41 FD
FE FEEDDZ 52 41 FD
FEFEEDDZ254 41 FD
FEFEEDDZ 55 41 FD
FE FEEDOZ 52 41 FD
FEFEEDDZ 591 41 FD
FEFEEDDZ 51 41 FD

=
Connected
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VERIFYING COMMUNICATION CONNECTIONS

Using the drop down menu you should see a list of all the communications channels you are
currently using. If one is missing then that channel has not been opened. If it is a serial port channel
make sure there are no duplicate COM ports selected and verify the cable connections to your serial
port and direction finder or modem. If it is a TCP/IP channel make sure your network cable is
connected or your WiFi card is on and make sure you can make a TCP/IP connection (e.g. use a web
browser to open a known web site.) If this works make sure that SignalTrack is in the run mode on
each end of the connection.

CHECKING THE DIRECTION FINDER AND RECEIVER ADDRESSES

When SignalTrack is controlling fixed site direction finders it is essential that each direction finder
and receiver have a unique CIV address. This can be verified by checking each individual site using
the Site Editor (see "Fixed Sites" on page 45); however, it can also be verified by observing the sent
messages after attempting a frequency change and attempting to change the direction finder settings.

After attempting to send messages to the receiver or direction finder, in the sent messages side of
the Incoming Data Screen you will see messages similar to

FE FE E0 02 XX ... FD
FE FE E0O 4A XX ... FD

The number directly after the EO is the CIV address of the destination of the message. These
addresses should correspond to the CIV addresses of the direction finder and receiver at the site.

If these addresses are correct and you are not receiving responses from the site, check the
connections at the site and the settings of any networking components.
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VERIFYING MOBILE COMPONENT COMMUNICATIONS

When using SignalTrack in a mobile site a four indicator display is shown on the tool bar as shown
below

[[E @ &

.550000 | [~ Phoenic WX @ N33 34 8.35" W111° 53° 9.39" | 6/13/2008 10:52:21 AM ::

162

Figure 64: Mobile Toolbar

The indicator in the upper left indicator flashes when a bearing message is received from the
direction finder, the lower left indicator flashes when a message is received from the receiver, the
upper right indicator flashes when a GPS message is received, and the lower right indicator flashes
when a message is received from the compass. The compass and GPS indicators should flash once
every second if they are connected properly and working. The direction finder and receiver
indicators should blink once every half second when a bearing is being received. The receiver
indicator should flash about once every 5 seconds when no signal is present.
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DISPLAYING INCOMING DATA FROM A MOBILE DIRECTION FINDER

In the View menu select Display Incoming Data. The following dialog will be displayed

Mobie Dot WEIE

Bearng GPS Heading Compass Speed
27|~ 157 |~ 130.9= 0~
28 15?_| 13:.E_| E_I
26 157 130.8 0
X7 157 1308 0
25 157 130.8 0
ze:I 157 1308 0

Latitude Longitude

W33® 35" 32 23" ;l W112° 12 48 51" ;l

N33® 35 32 23" W112° 12 43.91"

N33® 35" 32 23" W112° 12 48.91"

N33® 35" 32.23" W12 12 48.91"

M33® 35" 32.23" W112° 12 48.51"

M33d® 35' 32 23" W112° 12 43.91"

Declination 11.33

Figure 65: Use This Dialog to Verify the Compass and GPS are Working

If the GPS receiver is working and has converged you should longitudes and latitudes displayed. If
you are moving you should see a GPS heading that is consistent with your direction of travel and a
speed in km/hr that is consistent with your speed of travel. If you have a compass you should see a
compass output every | second. If you are tuned to a signal you should see a bearing that is
consistent with what is displayed on direction finder.

If you are not seeing GPS data check your connection and verify that you are not in an area where

the GPS satellite signals may be shielded from you (e.g. deep narrow canyons, tunnels, tall buildings,
etc.)
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Chapter 5
ERROR MESSAGES

When operating SignalTrack you may encounter some error messages. This chapter lists these error
messages, explains their meaning, and offers advice on what may be required to eliminate the error.

RECEIVER NOT RESPONDING

Error Message: Receiver at Site | did not respond to the last Set Frequency command.
Would you like to resend the command?

This message occurs if the receiver has not responded to a change in frequency from the software. If
you've been using the software for sometime and this error occurs simply press yes and see if it does
respond. If it still does not respond you may need to increase the response time by setting the Time
to wait for RX Response (see "Timing Options" on page 67).

If this message occurs after the system is first set up, make sure the direction finder and receiver are

powered and properly connected. Then make sure that the CIV address for the receiver is set to
the same value as was entered in the Site Setup (see "Fixed Sites" on page 45) dialog.

DIRECTION FINDER NOT RESPONDING

Error Message: Direction finder at Site | did not respond to the 3 command. Would
you like to resend the command?

This message occurs if the Direction Finder has not responded to a command that was sent to it. If
you've been using the software for sometime and this error occurs simply press yes and see if it does
respond. If it still does not respond you may need to increase the response time by setting the Time
to wait for DF Response (see "Timing Options" on page 67).

If this message occurs after the system is first set up, make sure the direction finder is powered and

properly connected. Then make sure that the CIV address for the direction finder is set to the same
value as was entered in the Site Setup (see "Fixed Sites" on page 45) dialog.

ETHERNET ERRORS

Error Message: Connection attempt timed out at Site I.

This error message will be displayed if the Ethernet connection cannot be made. Check your
Ethernet connection to make sure it is working. Check to make sure your Ethernet device at the
site is powered and operating correctly.

Error Message: Socket Error at Site 1. The connection has been refused by the remote
host.
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This error message will be displayed if the Ethernet device will not allow a connection to take place.
Use the Site Setup (see "Fixed Sites" on page 45) dialog check your IP address and port number
settings. If these settings are correct your Ethernet device may be in use by another program or has
held a connection. If using a DigiOne device, use the Web browser interface to terminate the
connection. See the DigiOne manual for details.

Error Message: IP port 2102 is currently being used by another program. Try specifying
and alternate port number for this server.

This message is displayed if SignalTrack has been enabled to accept data from other SignalTrack
programs and the port selected is being used by another program on the computer. Simply select a
different port number.

Error Message: Invalid IP address. Please correct.

The IP address that was typed in has an error in it. IP addresses must have 4 numbers all greater
than 0 and less than 256 separated by periods.

Error Message: Unable to connect to the SignalTrack at 127.0.0.1 port 2102. Try again?
This message is displayed when SignalTrack is acting as a slave and is furnishing data to another
SignalTrack application. Make sure the other application is running and has been configured to
Accept Remote (see "Accepting Data From Another Site Running SignalTrack" on page 58)
connections via Ethernet.

Error Message: Socket Error at Site 1.

This is a general socket error that will contain a description of the error. Contact the factory.

Error Message: An unexpected error occurred.

This is a general error that may occur during a failed socket read operation. Contact the factory.

SERIAL PORT AND MODEM ERRORS

Error Message: Unable to open port COM4. Check to see if another application is using
it.

This message indicates that another program is using the serial port. Check to see if an application
such as a PDA interface or terminal program is using the serial port.

Error Message: There are no serial ports available. Use the options dialog or delete a
site to free up a serial port.

SignalTrack keeps track of all the serial ports that are in use and all the available serial ports on the
computer. This error message indicates that all the serial ports on the computer are being used by
SignalTrack. If you are using a USB-to-serial converter check to see that it is working. Check the
options menu under the Remote tab to see if you are using any serial ports to monitor incoming
connections.

Error Message: Attempt to connect to site | timed out.
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This message occurs if the originating modem is not responding. Check the wiring to the modem.
Make sure the modem is connected to the proper serial port.

Error Message: Receiving modem at Site | did not answer.

This message occurs if the answering modem at the site did not answer.

Error Message: An error occurred while trying to connect to Site I.

General modem error. Check connections to the modem on both ends of the connection

Error Message: No dial tone detected on Site | modem. Check phone line connection.
Check the phone line to see if it is connected. Use a handset to monitor the line to see if it is dead.
Error Message: Line at Site | is busy.

The line at the answering modem is already in use.

Error Message: Invalid phone number. Please correct.

Phone number was entered incorrectly. Refer to Fixed Site setup (see "Fixed Sites" on page 45)
for allowed characters.

MOBILE SITE ERRORS

Location is not displayed

If your location is not displayed it's possible that the GPS receiver has not yet converged on a
location solution or you are in a location where the GPS signals not being received. To see the raw
data coming from your GPS, select Display Data... (see "Displaying Site Data" on page 90) from
the View menu and put the display in the ASCIl mode. You may also select Display Incoming
Data.. (see "Displaying Incoming Data from a Mobile Direction Finder" on page 93). to
view the data after it has been decoded.

If you see incoming data that is being decoded properly, check to make sure you are using a map for
your area and that the map has been properly calibrated using MapFix.

If you do not see and Comm data check your RS232 cable and connections. The required cable is a
straight through cable DB9M to DBYF that has pins 2, 3, and 5 connected as a minimum.

The DDF6002 is displaying a bearing but SignalTrack is not displaying a line of bearing

SignalTrack will not display a line-of-bearing unless it has both a heading from the compass or the
GPS and a bearing from the DDF6100/DDF6002. If a line-of-bearing is not being displayed
SignalTrack Track has probably not received a heading. Try driving a short distance to give the GPS a
chance to calculate a heading. If a line-of-bearing is displayed then you may have a faulty compass or
it may need to be reset. Try cycling power to the compass. You can view the incoming data by
selecting Display Incoming Data (see "Displaying Incoming Data from a Mobile Direction
Finder" on page 93) from the View menu.
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Calibration Time out
SignalTrack was unable to get a bearing from the Beacon or it was unable to get a heading from the

compass or the GPS. If you are not using a compass start the calibration again and move the vehicle
forward several meters.

FILE ERRORS

Error Message: Unable to open or create log file.

The directory you are using for the log files may have been accidently deleted. Check to see if the
selected directory (see "Recording a Log Files" on page 63) is an existing directory.

Error Message: Unable to open or create playback file.

The directory you are using for the playback files may have been accidently deleted. Check to see if
the selected directory (see "Recording Playback File" on page 64) is an existing directory.

PCR 1500 RECEIVER ERRORS

Error Message: There are no ports available for the PCRI1500 receiver. Check to see if
the receiver is turned on and connected to the computer. When receiver is properly
connected and turned on press Retry else press Cancel

Typically this message will occur if you have not connected the PCR 1500 to the computer or the
PCR1500 is powered down. If you get this message and the PCR 1500 is properly connected try
using the software furnished with the PCR1500 to see if the receiver is faulty.

Error Message: Cannot find the PCR1500.

Typically this message will occur if you have not connected the PCR 1500 to the computer or the
PCR1500 is powered down. If you get this message and the PCR 1500 is properly connected try
using the software furnished with the PCR1500 to see if the receiver is faulty.

Error Message: PCRI1500 is not responding.

Typically this message will occur if you have not connected the PCR 1500 to the computer or the

PCR1500 is powered down. If you get this message and the PCR 1500 is properly connected try
using the software furnished with the PCR1500 to see if the receiver is faulty.

MISCELLANEOUS ERRORS

Error Message: Unable to open LogViewer. Check to see if it is in the SignalTrack
folder.
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The LogViewer application may have been deleted or corrupted. Reinstall the SignalTrack
application.

Error Message: Mobile | has not responded for 600 seconds. Would you like to remove
this site?

The radio modem in the mobile is probably out of range or has been disabled. Removing the site will

simply remove it from the display. If the mobile comes back into range it will reregister on the
network and it will function normally.
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Chapter 6
UTILITIES

SignalTrack ships with WinRDF Command and AutoDFTest utilities. This chapter describes how to
use these utilities.

IN THIS CHAPTER
WINRDFCOMMAN ...ttt seseseeesesesessese e sesesessnnens 103
Y XU e B o =X T 109
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WINRDFCOMMAND

WinRDFCommand allows you to change the settings of a DDF6001I direction finder.

INTRODUCTION

WinRDF Command is designed to provide a simple computer interface to a Doppler Systems
DDF6001 direction finder. WinRDF Command can be used to send any of the commands supported
by the direction finder (see the DDF 6000 manual) via an RS232 connection with the direction finder.
It supports both ASCIl and CIV command formats. Additionally, WinRDF Command can send CIV
commands to ICOM receivers. This support allows the user to check out the direction finder-to-
CIV receiver connection as well as command the receiver to perform basic functions such as setting
the frequency of the receiver.
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GETTING STARTED

WinRDF Command is furnished as a part of the SignalTrack software suite and should have been
installed with your SignalTrack software.

To use WinRDF Command you must make a connection to the Direction Finder. If the DF is
connected via a serial port first connect a serial cable between your computer's COM port and one
of the serial connectors on the DDF6000. If connecting to J2 make sure you use a null modem cable.
If connecting to |4 make sure you use a CIV-to-RS232 converter. For further information on
connecting the DDF6000 to your computer see Chapter 6 of the DDF6000 manual.

If you have networked WinRDF Command on make sure the networking hardware/software is
functioning and note the IP address and IP port used.

When WinRDF Command launches one of the following dialog boxes is displayed

e |

: ___ = ~ Connection
PC Serial Por & Serial (COM) DF &dddesz |1 (011 =

i J1 x
DF Senial Port e P Addrass m e -
~Protocaob
LASC

= L

Commumication Parameters m |

~Connection——

Address " Serial [COM) DF Address I'I [01] 'I
{192 [ 1ee]] off 4 & FEE R Addess [3(08) =

F'thl 2101 —Protacal
i ASCH

i+ O

Figure 66: Use the Startup Screen to Set up Communications with the Direction Finder
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To connect to the direction finder via COM port, select the port you've connected the direction
finder to the computer. To connect via Ethernet, select TCP/IP and enter the IP address and IP port
of the network device that the direction finder is connected to. Next select the type of protocol
and the direction finder and receiver CIV addresses. Press OK and the program will indicate if a
connection has been made.
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DIRECTION FINDER SETTINGS

Once the connection is made, the following dialog is displayed

i WinRDF Command |

File Port Parameters Help

Direction Finder | F{E[:f:ivt:rl

—Averages | —Sweep Rate _‘:“Ut“ Output Update Rate
r 20 C 2400 _CalBRGD | - g:: S
10 &« 1200 Cal BRG to | |12I] &+ 0.50

—Self Test———— -
L Lo 1111 Cal BIG =19 | FE Dﬁes 1.00
=2 300 r1.20
Cal SIG =0 | C On :
- o0
DF Model | HEOD1f ~Pulse Mode
¥ Dim Display T i & Continous
ersmnl . " Pulse
I™ Attenuator : e Pul —Front Panel
244 b + Enable
Get DF Settings ;
g | < Meter q " Disahle
; ~Antenna——
Get Panel Settings I Test LEDs | e _PORT 2
= ICOM R
Factory Defaults
e | Avg Threshold [0.3 -] :: :rj:? 5912 Display
Heset Processor | DF Address [2 (02) = T AOR RX
—Sent ~Received
FE FE 02 EO OF FD «| IFE FE ED D2 FB FD
FE FE 02 ED 03 D7 FD FE FE ED 02 53 34 2E 32 34 FD
FE FE 02 EO OF FD FE FE ED 02 FB FD
FE FE 02 EO D3 AF FD FEFEED 02 52 2466 25 2F 18 FD
FE FE 02 EO OF FD FE FEED 02 FB FD
FEFE D2 EO D3 E5 FD FEFEED 025031 33 30FD
FE FE 02 EO DO FD FE FE ED 02 2C BA FD

Figure 67: Direction Finder Dialog

All the settings for the direction finder are explained in the DDF 6001 manual. In most cases, except
for the DF address, the default settings should be used. If the DDF6001 will be used on a direction
finding network, then each direction finder on the network is required to have a unique CIV address.
To set the CIV address simply select the address from the drop down list.
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WinRDF Command is designed to provide limited control of an ICOM R8500 or ICOM R7000
receiver. The dialog below illustrates the commands available

% WinRDF Command ]

File Port Parameters Help

Direction Finder Beceiver |

GHz MH=z

kHz Hz
o[ sz o[ o

Set Frt:qut:ncyl Get Frt:qut:ncyl

—Mode

~Mode BW

O AM " Marrow
T FM " Medium
T USB = Wide
- LSB
C CW Get

R Command

Send I I

; —Attenuato S - Mete
Hecenn ¥ PowerOn | & D 5 9
10 —
a0 Get
30
—Frequency Limits
Upper Lower ~AF Gain— ~Squelch—
00000000 000000 | 80 | 80
Get
Memory
_Recall | e L
1 = : :
Save | = 2
Set Set

—Sent

—Received

FE FE 02 EO 03 AF FD
FE FE 02 EO OF FD

FE FE 02 EO 03 E5 FD
FE FE 02 EO 00 FD

FEFE 08 E0 18 01 FD
FE FE 08 EO 18 00 FD
FE FE 08 E0 18 01 FD

FE FE ED 02 FB FD
FE FE ED 02 53 34 2E 32 34 FD
FE FE EO 02 FB FD

FE FE EO 02 FB FD
FE FE EO 02 50 31 33 30 FD
FE FE ED 02 2C 5A FD

FE FE EDO 02 52 24 66 25 2F 18 FD

Refer to the receiver manual for an explanation of the receiver commands.

Figure 68: Receiver Dialog
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AutoDFTest allows you to change the settings of a DDF6002 direction finder.

INTRODUCTION

AutoDFTest is a utility program that allows the user to change the internal settings of a DDF6002
direction finder. All of the settings are fully explained in Chapter 6 of the direction finder manual.
Below the basic operation of the program will be explained. Prior to running AutoDFTest connect
the peripheral devices (receiver, GPS, compass) to the direction finder and connect the direction
finder to the computer. Turn on the direction finder and then launch AutoDFTest.

STARTUP
At startup the following dialog box will appear
Setup |

PC Serial Part -
Baud Rate 9500 =
Stop Bits 1
Drata Bits ]

HANE

Parity Maone |=

I
-

Figure 69: AutoDFTest Startup Screen

In nearly all cases you should simply set the serial port to the port the direction finder is connected
to and accept the other parameters as defaults.
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DIRECTION FINDER SETTINGS

The following screen is displayed when a serial port connection is made

= DDF 61006002 Tester

Pot2 Pot3 Potd Help

File Por1

Diirection Finder | Flu:w'GPS.-"EDmpaSSI

—Averages—— —Auto Output——— [Update Ra
20 " Off 0.5
~ 10 Cal BRG 0 | Factory Defaults | C On 1.0
1.5
[ Cal BRG to | |1 20 Reset Processor | —Selt Test L=
e 2 e ; o ~Pulse On 1
1 Cal SIG = 9 | _DF Model | gopat o 150
SYY Uersiunl 4.23 —Pulse Mode 180
~Sweep Rate;  Cal 51G=10 |  Continous 200
2400 Bearing | 336 ~ Pul —
¥ Dim Displa i -
& 1200 oy S Meter 9 e Front Pane
[ Attenuator " Enable
" 600 A D
™ Pulse Test LEDs | Disable
" 300 o :
[ Cal —Antenna
L ||
SIN Ratio | - © VHF
" UHF1
Get Panel Settings " UHF2
—Sent Received
FI 05 $672 =|([sDFBRG,334,9.145
FO0E $337 $GPGGEA152953,3330 6363 M 112128151 W 2.09,1.0,356. 4 M 266 M.
FO 06 $382 FHCHDM.138.5.4726
FO 06 $333 $GPYTG.317.T,305.M,000.0,M.0000.0 K70
$DFBRG.336.9.147
[~

For specific guidance on all the commands and what they do, please consult Chapter 6 of the manual.

The Sent pane at the bottom of the display shows all commands sent to the direction finder and the
Received pane shows all data sent from the direction finder to AutoDFTest
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RECEIVER CONTROL

AutoDFTest offers some limited receiver control for ICOM and AOR receivers. The dialog below
shows the receiver screen

& DDF 61006002 Tester

File Potl1 PotZ2 Pot3d Potd Help
Direction Finder  Bow/GPS/Compass |

GHz kMHz kHz Hz —Receiver————— o —_ _
EERNEEENEE N E  R7O000 [a0 =] aituide N33 35 321
' : 9 il i [witz 12 88
 A0R
Set Frequency | Get Freguency | € Other GPS Time |3:4B:42 Ptd
—ode ~Frequency Limit GPS True Heading I':'
GPS Mag Heading |0
@ ap . Ipper Lower J q I
& M . 00000000 000000 Speed o
W edium
© sk Compass Heading |13?.9
O W amow Get
o LSE
© Cwf Get —hdemony
Recall |
R Commatd I-I 3’
Save |
Send I I
[ Sent Received
FO 0B $672 ;I $GPYTG.317.T,305,M,000.0,M 00000 K70
FO 0E $337 FHCHDM 137 9.M%25
FO 0B $382 $0FBRG,.235,9,1744

F 05 $333 $DFBRG.336.9.1+47
| $GPGGA 154842 3335.5349 N 112128141 3w/ 2.09,1.0,359.4 M -26.6. M.

=

Figure 70: ICOM 8500 Receiver Screen

In addition to the receiver control the GPS and compass data are displayed. If you do not see the
GPS data it could be that the GPS has not converged on the satellites. Look at the received screen
and look at the contents of the GPGGA and GPVTG messages. If these messages appear with
commas where the data should be then the GPS has not converged. If these messages are absent
then check the GPS power and data connections. If you have a compass connected you should see a
HCHDM message.
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